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本マニュアルについて 

本マニュアルは、一般化合物の測定、解析のトレーニングを目的として日本で作成した

簡易マニュアルになります。 

操作法、パラメータなどの詳細につきましては、CD内にあります英文の software guides

を参照ください。また、本マニュアルと英文のマニュアルに相違がある場合は、英文が

優先されます。 

 

TripleTOF® LC/MS/MS System / Analyst® TF / PeakView® /  MultiQuant™ ソフ

トウェアについて 

研究用にのみ使用できます。診断目的およびその手続き上での使用は出来ません。 

 

本文書は、SCIEX 製装置を購入した顧客が、本 SCIEX 製装置を操作するときに活用する

ものとして提供されています。本文書は著作権で保護されており、本文書の一部または

全部を複製することは、SCIEX が書面で許可する場合を除き、厳しく禁止されています。 

本文書に記載の装置は、米国、カナダおよびその他の国で申請された単数または複数の

特許のもとに保護されています。さらなる特許が出願中です。 

本文書に記載のソフトウェアは、ライセンス契約のもとに提供されます。ライセンス契

約で特別に許可される場合を除き、ソフトウェアの複製、変更または配布は、いかなる

媒体においても法律に違反します。さらに、ライセンス契約では、ソフトウェアの逆ア

センブル、リバースエンジニアリング、逆コンパイルを、いかなる目的においても禁止

します。  
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測定の準備 

1 測定の準備 

 Analyst® TF software の起動 

① Desktopの         アイコンをダブルクリックし、Analyst® TF software を起動しま

す。 

 

【各種モードについて】 

￭ Analyst® TF software は Configure、Tune、Acquire、Explorerの４種類のモードに分かれ

ています。選択しているモードに応じて、Tool Bar などから表示される機能が変わり

ます。 

￭ Configureモード: 使用するユーザーの権限、接続する LC などの機器の選択、レポート

形式を設定するモードです。 

￭ Tune モード: 装置のチューニング、測定条件の最適化、マニュアルでの測定、質量分

析器の質量補正（キャリブレーション）などを行うモードです。 

￭ Acquireモード: 測定用のメソッドおよびバッチを作成し、データを取り込みます。 

￭ Exploreモード: 主に測定中のデータの閲覧や簡易解析に使用するモードです。 

￭ Companion Software: Option Software などの追加コンポーネントの起動をこちらから行

うことができます。 

User 

Status  

装置の状況を確認できます。 

Navigation Bar 

使用するモード、機能を選択します。 

Project / Subproject 

保存先を指定します。 
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  装置の Configuration （仕様の選択） 

 装置の Configurationを行います。

Navigation Bar(画面左側)の Hardware 

Configuration をダブルクリックし

Hardware Configuration Editorを開きます。 

 目的の Configuration（Trainingでは

MassSpecOnly）を選択して、Activate 

Profileをクリックし、Activateします。 

 緑色のチェックがかかったことを確認

後、Closeをクリックし Hardware 

Configuration Editorを閉じます。 

* 新しい Profile を作成する場合は

Analyst® software 操作ガイドの’Profileを作成する’をご参照下さい。 

 

 Project (フォルダ) の作成 

 Tool Barの Toolsから Project -> Create 

Project…を選択します。 

 Project Name に適当な名前を入力しま

す。（Trainingでは Trainingを入力しま

す。） 

 OKをクリックすることで、Project が作

成され、画面上に表示されます。 

 

 

 

 

 

 

 

【Project / Subprojectについて】 

￭ Analyst® TF software のデータは Projectで管理します。測定試料や測定者が変わるとき

は Projectの作成、変更を推奨します。 

￭ すべての Projectは Defaultで D:\Analyst Data\Projectsに保存されています。 

￭ Subprojectの使用は測定時不具合が起きる場合がありますので、推奨していません。ま

た、Shimadzu LC システムの PDAを使用する場合は、Subprojectを使用できません。 

【API Instrumentについて】 

￭ D:\Analyst Data\Projects 内の API Instrument という Project は、装置のキャリブレーショ

ンやパラメータなど非常に重要なファイルが入っています。定期的な Back Up を推奨

します。また、通常の測定を行う際にこの Project を使用してファイルを保存したり、

キャリブレーション用の測定法を削除したりすると、測定に障害を生じることがあり

ますので、ご注意ください。 

② 

③ 

プロジェクトが作成

されるフォルダ 
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 分析のワークフロー 

• 以下を参考に、分析の前にスペックチェックあるいは Instrument Optimization 等を行

うかの確認をします。 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• 感度につきましては、導入時の Verify の結果あるいはお客様の標品などで確認を

行い指標にすることをお勧めします。 

• スプレーのポジションは Infusion および LC/MS 分析時で変更します。一般的な溶

媒使用時の推奨値は以下になります。 

 Infusion（流速 5-20µL程度）： 縦 5mm、横 5mm 

 LC/MS（流速 200-500µL 程度）：縦 3mm、横 7mm（実際の分析時は最適化し

て変更することも可能、詳細は LC/MS の項を参照ください。） 

 

  

同じ条件で

連続分析中 

No 

CDSを用いた Auto Calibration を行い LC/MS 分析をします。 

Yes 

Manual Calibration 

11頁以降を参考に、使用する極性・スキャンモードについて

Manual Calibrationを行い精度を補正します。 

 

チューニング 

82頁以降を参考に使用する極性、スキャンモード、その他必要な項目を装

置のチューニング Instrument Optimization を行います。 

 

スペックチェック 

・ 9 頁以降を参考に、使用する極性・スキャンモードについて Instrument 

Optimization の“Verify”を行い、以下の条件を満たすことを確認します。 

o Mass Shift ±200ppm以下 

o 分解能 m/z 956以上で基準値（9 頁参考）以上 

 

同じ条件で連続分析中でない、以下に該当する 

・ 装置の状況を確認したい。 

・ 数日分析していない。 

・ しばらく使用していない極性、スキャンモードを今回使用する。 

・ 停電後あるいは真空解除したメンテナンス実施後。 

Yes 

Mass Shift ±200ppm 以上 
 

分解能が m/z 956 以上で基準値以下 
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 標準試薬とイオン源の準備 

 使用する極性 (Positive or Negative) の装置のスペックチェッ

ク用の標準溶液をシリンジに挿入し、装置にセットします。 

* Trainingは Positive Modeで行います。標準溶液としてAPCI 

Positive Calibration Solution用いて行います。 

 スプレイヤーの Position（右図の矢印）をそれぞれ目盛 

（縦 (V) 5mm、横 (L) 5mm）にセットします。 

 

【標準溶液について】 

￭ 弊社の推奨は以下になります。 

 

 

 

￭ TripleTOF® 6600、5600+ System の場合は、上記溶液を希釈して使用することも可能で

す（2mM酢酸アンモニウム/50％アセトニトリル/水溶液の 2倍希釈など）。 

￭ スペックチェックと Calibrationで異なる標準溶液を使用することもできます。 

￭ 装置の管理のため、スペックチェックに使用する標準溶液は固定されることを推奨し

ます。 

￭ 他の試薬を使用する場合は、添付資料を参考に Calibration Tableを作成ください。 

 

 装置の起動と準備 

 Navigation Barの Tune and Calibrateをクリックします。 

       をを 2回クリックします。 

* 画面右下の Mass及びシリンジポンプの表示が黄色から緑に変わります。 

 Navigation Barの Manual Tuningをダブルクリックし、Tune Method Editor画面を

立ち上げます。 

 

極性 推奨する標準溶液 
製品番号 

1 Pack 5 Pack 

Positive APCI Positive Calibration Solution 4460131 4460136 

Negative APCI Negative Calibration Solution 4460134 4460138 

Tune Method Editor 

④ 

③ 

② 

② 

① 

L 

V 
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⑦ 
⑦ 

⑧ 

⑨ 

⑩ 

⑫ 

⑥ 

 MS Methodのプルダウンメニューから Syringe Pump Methodを選択します。 

 Syringe Diameterに使用するシリンジの内径、Flow Rateを入

力（Trainingでは 4.61、10）、Unitに μL/min を選択します。 

 Syringe Pump Methodのプルダウンメニューから MS Method 

に戻ります。 

 MS タブをクリックし、Scan Typeに TOF MSを選択後、TOF 

Masses (amu)の Min、Maxに測定質量範囲（Trainingでは

100、1000）を入力します。 

 

 

 

 

 

 

 

 

 

 

 目的の Polarity（Trainingでは Positive）を選択します。 

 Source/Gasの設定（Trainingでは以下の tableの初期値で設定）を行います。 

 Durationに測定の継続時間（Trainingでは 5）を入力します。 

 File menuの Save As…で、作成した Methodを適当な名前(Training では

Pos_Infusion)で保存します。 

 標準溶液をシリンジポンプにセットし、Start Syringeをクリックしてサンプルを

MS に導入し、Startをクリックして測定を開始します。 

【パラメータと Infusion 測定時の初期値】 

   略語  説明 説明 
初期値 

(Negative) 

Compound 

DP Declustering Potential  (V) オリフィスプレートにかかる電圧 80 (-80) 

CE Collision Energy  (V) 
コリジョン 

     エネルギー  

MS 10 (-10) 

Product Ion  35 (-35) 

Source/Gas 

GS1 Source Gas1 (psi) ネブライザーガス  15 

GS1 Source Gas2 (psi) ターボガス 0 

CUR Curtain Gas (psi) カーテンガス  15 

TEM Temperature (℃) ヒーター温度 0 

ISVF IonSpray Voltage Floating (V) プローブにかかる電圧  5500 (-4500) 

￭ 実際のサンプルの分析の際は、状況に応じて上記値を変更してお使いください。 

￭ 熱に不安定な化合物やインソース CID を受けやすい化合物を分析される際は、TEMお

よび DP を低めに設定してください（例 TEM ： 350、DP ： 30程度）。 

￭ TEMは最大 700 度で使用してください。750 度はヒーターの寿命が短くなります。 

Volume 
( μL ) 

Diamet
er (mm) 

1000 4.61 

500 3.26 

250 2.3 

100 1.46 
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⑬ 目的の標準物質のイオン（Trainingでは APCI Positive Calibration Solution) のイ

オンが観察され、TICが安定するのを待ちます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

⑭ TIC 安定後、0.5～1分後、Stopをクリックします。 

 

 スペックチェックの実施 

￭ 装置の感度、分解能を確認します。 

 Navigation Barの Instrument Optimization をクリックします。 

* 右図のメッセージが表示された場

合、OKしてBackupを作成します。 

 

 

 

② Instrument Optimization の画面(下図)

で、Tuning Solutionに使用する Calibration Table名、Polarityを選択します。  

(Trainingでは APCI Positive Calibration Solution、Positiveを選択してください。)  

③ Verify Peformance Onlyにチェックをかけ、Nextをクリックします。 

 

 

 

 

 

APCI Positive 
Calibration Solution 

APCI Negative 
Calibration Solution 

① 

② ② 

③ 

③ 
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④ 右図を参考に、イオン源の設定

（8ページ に記載の初期値、

Trainingでは以下）と使用するシ

リンジの内径、Flow Rate

（Trainingでは 4.61, 10）を入力

後、画面下の Go!をクリックし、

装置のチェックを開始します。 

⑤ 終了後、レポートが作成され、以

下のフォルダ内に作成される取得

日時のフォルダ内に保存されます。 

D:\Analyst Data\Projects\API Instrument\Data\Instrument Optimization 

⑥ 実施した取得日時名フォルダ

内の results.docを開き、

Resolutionと Hightを基準値と

比較し、Resolution同等程度

以上、Hightが基準値を大き

く下がっていないことを確認

します。 

* 上記を満たしていない

場合はトラブルシュー

トの頁へ進みます。 

⑦ 必要に応じて、①に戻り、別

の極性（Positive/Negative）に

ついてチェックを行います。 

 

 

 

装置の Resolutin, Height の基準値 

* Height につきましては、装置、試薬、溶液により異なります。メンテナンス後

など装置が汚れていない際に、標準品を測定、記載ください。 

 
 

Mode 
Resolution 

Height 
6600 

5600 
5600+ 

4600 

Positive 

TOFMS at m/z 829.5 32000 30000 25000  

Product Ion High Res. at m/z 397.2 30000  

Product Ion High Sens. at m/z 397.2 15000 －  

Negative 

TOFMS at m/z 933.6 32000 30000 25000  

Product Ion High Res. at m/z 514.3 30000  

Product Ion High Sens. at m/z 514.3 15000 －  

 

5600+, APCI 
Positive Calibration 

Solution 使用時の 

results.doc の例 

あ

あ

あ

あ 

③ 

④ ④ 

④ 
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 Manual Calibration 

* 使用する極性（Positiveおよび

Negative Mode）とスキャンモード

（TOFMS, Product Ion Scan 

（TripleTOF®6600、 5600+ System 

の場合は High Resolution (HR) 

Modeと High Sensitive (HS) 

Mode）すべてにおいて Calibration

を行う必要があります。 

* 使用する標準溶液は APCI Positive Calibration Solution、APCI Negative Calibration 

Solutionあるいはその希釈液（7ページ）を推奨します。 

* 他の試薬を使用する場合、巻末の参考資料を参考に、Calibration Table を作成し

てください。 

* Calibration には Auto と Manual の 2 種類があります。この項では Manual 

Calibration について記載します。Training ではイオン源は DuoSpray、極性は

Positive Mode、標準溶液として APCI Positive Calibration Solution を用いて

Calibration を行います。 

* LC/MS 分析の際は CDS を用いた Auto Calibration を行いますので、精度が大き

くずれた場合を除いて Manual Calibrationは必要ありません。 

 

1.8.1 TOF MS 

 Navigation Barの Tune and Calibrateをクリックします。 

     をクリックします。 

 Navigation Barの Manual Tuningをダブルクリックし、Tune Method Editor画面を

立ち上げます。 

 File menuの Openから、準備で保存した Method（Trainingでは Pos_Infusion）を

開きます。（ErrorMessageは Noで終了してください） 

 標準溶液をシリンジポンプにセットし、Start Syringeをクリックしてサンプルを

MS に導入します。 

 Startをクリックします。 

  

  Pos Neg 

6600 
5600+ 
5600 

TOFMS   

Product Ion HR   

Product Ion HS   

4600 
TOFMS   

Product Ion   

Calibration チェックリスト 
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 目的の標準物質のイオン（Trainingでは APCI Positive Calibration Solution) の 

ピークが観察され、TICが安定するのを待ちます。 

 

 

 

 

 

 

 

 

 

 

 

 TIC の安定後、0.5～1分後、Stop Syringe、Stopをクリックし、シリンジ、測定

を止めます。 

* 測定を stopして終了したデータでない場合、Manual Calibration ができません。 

 TIC 上で目的の標準物質のイオンが出ている部分を左ドラッグで選択後、ダブ

ルクリックし、マススペクトルを表示させます。 

* 手動で目的のイオンを選択する場合はそのピークを左ドラッグして（複数ピー

クを選択する場合はシフトキーを押しながら）選択します。 

 スペクトル上で右クリックし、Recalibrate TOF を選択します。 

 Reference Tableから、目的の Calibration Table (Trainingでは APCI Positive 

Calibration Solution)を選択し、Tolerance に適当な値（Trainingでは 0.2）を入力

します。 

* Theoretical Mass（選択した Table に登録されている理論値）、Experimental Mass

（入力した Tolerance内で最も強い Peakの実測値）が自動入力されます。  

APCI Positive 

Calibration  

Solution 

APCI Negative 

Calibration  

Solution 

TIC MS 

⑨ 

 

拡大する時は軸のエリアをドラッグ、全範囲に戻る場合はダブルクリックします。 

ピークに

m/z の表示

がない場

合は、Y 軸

上の青三

角印▶を下

げます。 

TIC 

⑩ 
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 Calibrate new Calibrations → Calibrate spectrumの順にクリックし、Set As 

Instrument Defaultにチェックが入っていることを確認後、Entire Fileをクリック

します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 保存名に適当な名前を入力し（変

更の必要ありません。）、保存しま

す。 

 OKを 2回クリック後、Closeを  

クリックして終了します。 

* この操作により、このデータと

これ以降の Positive の TOFMS の 

データが補正されます。 

 

 

 

【Calibrationとトラブルシュート】 

* Calibration画面では、Reference Tableを選択することで、Theoretical Massに選択

した Table に登録されている理論値、Experimental Mass に入力した Tolerance 内

で最も強い Peak の実測値のリストが入力されます。 

Q1)  Experimentalに表示される数が少ない。 

A: スペクトルに戻り、Y 軸上の青三角印▶を下げ、目的の m/z を表示させて、再度操

作を行ってください。 

Q2) Experimentalに何も表示されない。 

A: 装置のメンテナンスや Tuning後など、大幅に Massが Shiftしている場合がありま

す。この場合、Toletrance を広げる、再度 Reference Table を選択するの操作を、数

値が表示されるまで繰り返します。数値が表示された後、Calibrate new Calibrations

をクリックし、画面右の*の Calibration Error の値が数 ppm 以内であることを確認

後、操作を続けてください。 

  Pos Neg 

6600 
5600+ 
5600 

TOFMS ✓  

Product Ion HR   

Product Ion HS   

4600 
TOFMS ✓  

Product Ion   

0.2 

* 

Calibration チェックリスト 
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1.8.2 Product Ion Scan 

* TripleTOF® 6600、5600+ System の場合、Product Ion Scan には High Resolution 

(HR) Mode および High Sensitive (HS) Modeがあります。 

*  High Resolution Mode、High Sensitive Modeについては 15頁を参照ください。 

 MS のタブをクリックし、Scan Typeを Product Ionに変更し、使用予定の High 

Resolution Modeあるいは High Sensitive を選択します。 

* 4600では必要ありません。Trainingでは High Sensitivityを選択します。 

② Product Ofに Product Ion Scan

に使用する親イオン*の m/z

（Trainingでは 609.3）を入

力します。 

③ TOF Masses (Da)の Min, Max

に測定質量範囲（Trainingでは 100、1000）を入力します。 

④ Compound のタブをクリックし、Collision 

Energy (CE)に適当な値*(Trainingでは 45)を入

力します。 

⑤ Start Syringe、Startをクリックし、目的の標準

物質の Product Ion のピークが観察され、TIC

が安定するのを待ちます。 

⑥ TIC の安定後、0.5～1分後 Stop Syringe、Stop

をクリックし、シリンジ、測定を止めます。 

⑦ TOFの Calibrationの⑧以降と同様な操作を行

い、Product Ion の補正を行います。 

* この操作により、このデータと以降の

Positive の Product Ion HS のデータが補正さ

れます。 

* TripleTOF® 6600、5600+ System の場合、必要に応じて Product Ion Scan の High 

Resolutionも同様の操作で実施します。 

⑧ 上記 Tableを参考に、必要な極性、モード

ずべてについて、同様に Calibrationを行

います。 

   

APCI Calibration Solution 使用時の設定値 
 ②Product of ③Mass Range ④CE 

Positive 609.3 100-1000 45 

Negative 403.1 70-1000 -27 

  Pos Neg 

6600 
5600+ 
5600 

TOFMS ✓  

Product Ion HR   

Product Ion HS ✓  

4600 
TOFMS ✓  

Product Ion ✓  

① 

② 

③ ① 
④ 

⑤ 
⑤ 

APCI Positive 
Calibration  
Solution 

APCI Negative 
Calibration 
Solution 
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【 High Resolution (HR) Mode と High Sensitive (HS) Modeについて】 

HS Modeにて測定を行うと、HR Modeに比べ感度向上が期待できます。ただし、

HS Modeでは HR Modeに比べて分解能が落ちるため、ごく近傍に夾雑ピークが存

在する場合は、HRモードで測定することを推奨します。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 CDS の準備 

* LC-MS の測定時、前回の測定から時間があいている

場合や、イオン化法の変更などで標準溶液を変更し

た場合に行います。 

* CDS の動作の詳細につきましては、添付資料を参照

ください。 

 使用する極性（Positive あるいは Negative）のボトル 

（それぞれ CalAと CalBに接続）に測定に十分な量の標

準溶液が入っていることを確認します。 

 測定目的の極性であることを確認後、画面右上の CDS 

Purgeをクリックし、終了するまで 5分待ちます。 

* Purge中は CDS Stopの表示に代わります。Purgeが終了

す る と 、CDS 

Purge に表示が

戻ります。 

* Training では、

Stop をクリッ

クし、途中終

了させてくだ

さい。 

  

HR (High Resolution) 

HS (High Sensitivity) 
 

HS (High Sensitivity) 
m/z 116.1069 拡大図 

HR (High Resolution) 
 

CalA: 
Positive 

CalB: 
Negative 
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Tune Mode を用いた Manual 測定 

2 Tune Mode を用いた Manual 測定 

* Training ではイオン源は DuoSpray、サンプルとして Positive Calibration Solution

を用いて、Reserpine測定を行います。（流速：10μL/min） 

 

 測定モードおよび測定時の機能について 

➢ 測定モード 

TOF MS 

MS を測定するモードです。分子量関連イオンを測定する際に使用します。 

Product Ion Scan 

Product Ionを測定するモードです。Fragmentationは Collision Cellで行われま

す。 

* Q1: Precursor Ion の選択 → Q2 Collision Cell: Fragmentation → TOF: 測定になりま

す。 

* TripleTOF® 6600、5600+ System は High Resolution Mode および High Sensitive 

Modeの 2 種類の設定（15項参照）があります。(TripleTOF® 4600 Systemは 1種

類です。) 

Precursor Ion Scan 

Product Ion から Precursor Ion の情報を得るモードです。TripleTOFでは高速測定が

可能なため、Precursor Ion Scanの使用ではなく、後述する IDA で測定した Dataか

ら、解析で Precursor Ion の情報を得ることを推奨しています。このため、Training

では行いません。 

 

➢ 測定時の機能 

Auto Calibration 

指定したイオンで常に Calibrationを行います。 

Enhance 

指定した m/z 付近のイオンの TOF

への導入効率を上げて測定しま

す。m/zの小さい領域について有

効です。定量測定時によく使用し

ます。 

* Enhance 機能使用時は、非使用

時と Calibration が異なりますの

で、精密質量測定の際は、必要

に応じて補正しなおしてくださ

い。  
m/z 

E
n

h
a
n

ce
m

en
t 

fa
ct

o
r 

Enhanceの効果 
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 TOF MS 

 MS のタブをクリックし、TOF Masses (amu)の Min、Maxに測定質量範囲を入力

します。 

* Trainingではそれぞれ 100、1000を入力してください。 

② サンプルをセットし、Start Syringeをクリックしてサンプルを MS に導入しま

す。 

③ Startをクリックします。 

④ 目的物質のイオン（Trainingでは 609）のピークが観察され、TIC が安定するの

を待ちます。 

⑤ Stopをクリックします。 

* TOF MSスペクトルで Fragment Ion が観測される場合は Compoundのタブの DP

を下げてください。 

 

データの測定と保存 

① Manual Tuningの Acquireのボタンをクリックし Sample Name、Data Filename、

Commentにサンプル情報などを入力します。 

② Trainingでは Data File Name に ResTOFMS と入力してください。 

③ OKをクリックすると測定が始まり、データが保存されます。 

④ 途中で測定を止めるときは Stopをクリックします。 

⑤ 測定終了後、Stop Syringeをクリックし、シリンジを止めます。 

* 引き続き測定を行う場合はシリンジポンプを止めなくても構いません。

Trainingでは止めずに測定を続けます。 
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 Product Ion Scan と Enhance 

* TripleTOF® 6600、5600+ System の場合、Product Ion Scan には High Resolution 

Mode および High Sensitive Mode があります。Calibration 済みの Modeを使用く

ださい。 

 MS のタブをクリックし、Scan Typeを Product Ionに変更し、High Resolution 

Modeあるいは High Sensitive を選択します。 

* High Resolution Mode、High Sensitive Modeについては 15頁を参照ください。 

* 4600では設定がありません。Trainingでは High Sensitivityを選択します。 

② Product Ofに目的の親イオン*の m/z（Trainingでは 609.3）を入力します。 

③ TOF Masses (Da)の Min, Maxに測定質量範囲（Trainingでは 100、1000）を入力

します。 

④ Compound のタブをクリックし、Collision Energy (CE)に 10、Collision Energy 

Spread (CES)に 0を入力します。 

* CES については 19頁を参照ください。 

⑤ Resolutionのタブをクリックし、必要に応じて、Q1の分解能（19頁参照、

Trainingではデフォルトの Unit）を変更します。 

⑥ Start Syringe Pump をクリックしてサンプルを MSに導入します。 

⑦ Startをクリックします。 

⑧ Precursor Ion（Trainingでは 609）を確認後、フラグメントイオンのパターンを

観測しながら、Compoundのタブで CE, CESの値を最適化します。 

⑨ Precursor Ion（Trainingでは 609）を確認後、フラグメントイオンのパターンを

観測しながら、Compoundのタブで CE, CESの値を最適化します。 

⑩ Stopをクリックします。 

⑪ 測定終了後、Stop Syringeをクリックし、シリンジを止めます。 

* 引き続き測定を行う場合はシリンジポンプを止めなくても構いません。

Trainingでは止めずに測定を続けます。 

 

データの測定と保存 

前項のデータの保存と測定の方法と同様に、Acquireをクリックし、測定を行い

ます。 

* Trainingでは Data File Name に ResMSMSと入力してください。 

拡大 

① 

② 

③ ① 
④ 

⑥ 
⑤ 

 

⑦ 
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【CES (Collision Energy Spread) について】 

数値を入力することで、CE-CESから CE+CESの値で CEを掃引しながらスペク

トルを取得します。 

例）CE 45, CES 15 の場合：CE 30-60V で測定を行い、全 CEの平均のスペクト
ルが表示されます。 

* IDA や SWATH など、低分子から高分子、開裂しやすい化合物から開裂しにく
い化合物など、網羅的な成分の自動測定を行う場合に有効です。 

* 定量時など、化合物ごとに最適なCEがある場合は、通常CES 0を使用します。 

* CES を使用する場合、Accumulation time は、25ms以上に設定してください。 

* 得られるスペクトルは平均のスペクトルになります。得られた結果から各 CE

のスペクトルの閲覧はできません。 

 

【Resolutionについて】 

Q1 Resolutionは Product Ion Scan および Precursor Ion Scanの際に、Q1を通過さ

せるイオンの m/zの範囲になります。 

Unit:  設定値から±0.7±0.1 amuの範囲 

High: 設定値から±0.5±0.1 amuの範囲 

Low:  defaultの設定で設定値から±1.5～2amuの範囲（変更可能） 

Open:  defaultの設定で設定値から±～4amuの範囲（変更可能） 

 

 

 

 

 

 

 

 

 

  

Reserpine, CE45V 
 

397 195 
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 Enhance 

* TripleTOF® 6600、5600+ System の 場 合 、High 

Sensitive Modeのみで使用できます。 

① Compound のタブをクリックし、Enhance にチェックを

かけ、目的の m/z（Trainingでは 195.1）を入力し、

Applyをクリックします。 

② 前項ののデータの保存と測定の方法と同様に、Acquire

をクリックし、測定を行います。 

* Trainingでは Data File Name に ResMSMSEnh195と入

力してください。 

* 測定中、マススペクトルの m/z のレンジが Enhance されている付近に変わりま

す。全体を表示させる場合は、マススペクトル上を右クリックし、All Mass 

Rangesを選択してください。 

③ 測定終了後、Stop Syringeをクリックし、シリンジを止めます。 

④ Enhanceのチェックを外し、Applyをクリックします。 

  

 

 

 

 

 

 

 

 

 

 

 

 測定の終了、流路の洗浄 

 シリンジ及び流路を洗浄します。 

* サンプルが溶解する溶媒を導入し、TOF MS を選択、Start をクリックし、サン

プルのピークが出なくなったことを確認後、終了してください。 

② シリンジ及び流路を水/メタノール＝1/1など、適当な溶媒に置換します。 

③ Tune Method 画面を閉じます。 

* Methodを保存する場合は Yes、保存しない場合は Noを選択して終了します。 

④ Tool Barの   をクリック後、  をクリックして装置を Standbyにし、ガス

の流量と検出器の電圧を最小限に落とます。 

* 画面下の Mass及びシリンジポンプの表示が緑から黄色に変わります。 

Enhance 195 

Enhance なし 
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データ解析（基本編: Analyst®TF ） 

3 データ解析（基本編: Analyst®TF Software） 
 

【Analyst  Explorerモードと PeakView® Software の違いについて】 

• スペクトル解析は Analyst の Explorerモードおよび PeakView® Software の 2通りの
方法があります。以下の主な違いを参考に、目的に応じて使用ください。 

• 測定後の解析においては、より軽快で高機能な PeakView® Software を推奨します。 

• PeakView® Software の詳細な説明につきましては、ユーザーマニュアル（日本文、
英文）、Reference Guide （英文）を参考ください。英文の資料につきましては、
PeakView® Software の Help から参照することが可能です。 

 

Analyst® の Explorerモード 

• 従来の Analystに搭載されている解析モードです。 

• 測定中の Dataについての解析が可能です。 

• Dataのサイズにより、Dataを開くまでに時間がかかる場合があります。 

• MS/MSの Library Search が可能です。 

 

PeakView® Software 

• Analyst TF用に開発された、新規 Softwareです。 

• 測定中の Dataは開くことができません。 

• 複数の Data を一度に選択して開くことができます。また、同時に解析することが
可能です。 

• IDA Explorer、Fragment Ion の帰属など様々な機能が追加、改良されています。 

• MS/MS の Library Search はできません。MasterView/LibraryView Software で行いま
す。 

 

 Analyst の Explorer モードを用いた解析 

* Training では、Infusion の Data を Analyst の Explorer モード、LC-MS の Data を

Analyst の Explorer モードおよ

び、PeakView® Software を使用

して解析を行います。 

Open Data 

• Navigation Bar の Explore の Open 

Data File をダブルクリックし、

Select Sample 画面から目的のデー

タファイル、サンプルを選択し

OKをクリックします。 

* Training で は 取 得 し た

ResTOFMS を選択してくださ

い。 
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スペクトルの表示 

• TIC 上で目的の時間を

ダブルクリック、ある

いは目的の時間の範囲

を左ドラッグで選択後

ダブルクリックするこ

とで、選択した範囲の

平均のマススペクトル

が表示されます。 

 

ピークラベル(m/z)の表示 

• Y 軸に表示されている

三角形のマークをドラ

ッグするとピークラベ

ルの閾値を変更することができます。 

 

スペクトルの拡大 

• スペクトルの縦軸もしくは横軸の外側を左ドラッグすることによりスペクトルを

拡大することができます。 

• 元に戻す際は、拡大した横軸の外側をダブルクリックあるいは Tool Barの    を

クリックして下さい。 

 

スペクトルの表示を隠す、消す 

• Tool Barの   （表示を隠す）あるいは   （表示を消す）をクリックします。 

* Trainingでは TIC を隠してください。 

* 隠した画面については   をクリックすることですべての画面が表示されます。 

* １つの画面を全画面にしたい場合は    をクリックしてください。 
 

スペクトルの移動 

* Training では ResMSMS、

ResMSMSEnh195 の 感

度、スペクトルの比較を

行います。データを開

き、それぞれ解析してく

ださい。 

① 移動させるスペクトル上を

クリックし、Tool Barの   

をクリックします。 

② 目的のスペクトルの枠付近

にマウスのカーソルを移動

し、  を表示させた状態でマウスを左クリックしながらスペクトルを移動し

ます。 

Enhance なし 

Enhance 397 
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LC-MS、Acquire Mode での測定 

4 LC-MS、Acquire Mode での測定 
 

 装置の Configuration と準備 

 右図を参考に、CDS, LCとの接続を行いま

す。 

* APCI 使用時は配管が異なります。の接

続を入れ替えてください。 

② スプレイヤーの Position（右図の青矢印）を

以下を参考に、適当な目盛にセットします。 

③ 必要に応じ、以下を参考にスプレイヤーの先端

部分を調整します。 

 

 

 

 

 

 

 

 

 

 

④ Navigation Barの Hardware Configuration をダブルクリックし Hardware 

Configuration Editorを開きます。 

⑤ LC のポンプ、オートサンプラー等を制御する Profileを選択し Activate Profileを

クリックします。 

* 島津社製の PDA について、使用する、しないを切り替える場合は、Hardware 

Configuration画面でDeactivate Profileをクリックして現在の Configurationを切っ

た後、HPLC を再起動し、再度変更後の Profile を選択後、Activate してくださ

い。使用しない場合は、PDAなしの Profileを使用されることを推奨します。 

⑥ Activateされたことを確認後、Hardware Configuration Editorを Close します。 

* 新しい Profile を作成する場合は Analyst® Software 操作ガイドをご参照下さい。 

 

  

Flow Rate 

(L/min) 
Probe Position Protrusion 

10-50 
V=5-10 

~2 mm 
L=4-6 

51-150 
V=3-7 

~1 mm 
L=4-6 

151-400 
V=0-5 

~1 mm 
L=4-6 

401-800 
V=0-3 

~1-0.5 mm 
L=4-6 

Above 800 
V=0-2 

~0.5mm 
L=3-7 

CDS 

LC 

 

 

L 

V 

Protrusion 

(先端の出て

いる長さ) 
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 Method Wizard を用いた Method 作成 

【Method Wizardについて】 

* TripleTOF Systemでは Method Wizard から簡便に Method作成が可能です。 

* ▼から Template を選択、あるいは、Browse から以前作成した Method を使用し、

Methodを作成することができます。 

* MS、LCの測定条件を組み合わせ、新しいMethodを作成することができます。 

* 装置により、使用できる Method  (Template)が異なります。 

 

低分子化合物の分析で主に使用する測定法と目的 

① IDA：定性分析、Data Dependent Acquisition 

② SWATH：定性分析、Data Independent Acquisition 

③ MS/MS：定量、目的物質の MS/MS 

④ TOF MS-MS/MS：定量、MS および目的物質の MS/MS 

 

その他の測定法と目的 

⑤ Infusion IDA：Infusion測定時の IDA 

⑥ Neutral Loss IDA：Neutral Lossからの IDA、主に代謝物同定で使用 

⑦ Precursor ion：Precursor ion Scan 

⑧ Proteomics IDA, iTRAQ：タンパク同定、定量 

⑨ Small Moecule IDA DBS：定性分析、③からも同じ Method作成可能 

⑩ TOF MS のみ  

TripleTOF® 4600 System TripleTOF® 6600, 5600+ System 

① 

⑥ 

③ 

④ 

② 

⑤ 

⑦ 

⑧ 

⑨ 

⑩ 

① 

⑥ 

③ 

④ 

② 

⑤ 

⑧ 

⑨ 

⑩ 
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 Method の作成 -1 IDA 

Trainingでは、Positive Modeの IDA_ TOF MS-10MS/MS（定性用）および TOF MS-

MS/MS （定量用）について作成、測定を行います。 

* Training ではイオン源は DuoSpray、サンプルとして APCI Positive Calibration 

Solution を使用します。（溶媒：0.1%ギ酸/水、0.1%ギ酸/アセトニトリル、

Column Size 2.0～2.1mm、LC の流速：200-400μL/min、inj. Volume 5μL） 

* 以前に作成した Method を使用する場合は Navigation Bar の Acquire をクリック

した後 Project を目的の Method が保存されている Project に切り替えて、メニュ

ーバーの File  ->  Open から Method を呼び出します。次に今回使用する Project

に切り替えて、メニューバーの File ->  Save as…で Methodを保存し直してくだ

さい。 

① Navigation Barの Method Wizard 

をダブルクリックします。 

② Choose Methods タブの Choose 

MS Methodで目的の MSの

Methodを選択します。 

* Training では下矢印から

Template を 開 き 、Small 

MoleculeIDA DBS (+) を選択

してください。 

* 以前測定した Methodを開く場合は Browseから選択してください。 

③ 以前作成した LC 条件を使用する場合、Choose LC Methodで Browse…から目的

の LC 条件を選択します。作成済みの LC 条件がない場合はスキップします。 

* Trainingでは選択しません。 

④ Save Method AS: で保存する File名(Trainingでは IDA)を入力後、Enterキーを押

します。 

⑤ Nextをクリックします。 

⑥ Ion Source Parameters Tabで適当な parameterを入力し Nextをクリックします。 

* 以下の Table を参考に入力します。最適化した値がある場合はその値を使用し

てください。 

 

 

 

 

 

 

 

 

 

Flow Rate  

(L/min) 
10-50 51-150 151-400 401-800 

Above 
800 

CURb 15-20 25 30 35 40 

GS1 30-10 30-50 40-70 50-90 60-90 

GS2c 0-30 30-50 40-70 50-90 60-90 

TEMa 0-150 150-250 250-500 500-650 600-750 

 General Settings to Use When Beginning Method Development 
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* Training では右のように入力してく

ださい。 

⑦ IDA タブで parameterを入力します。 

* Training では下図のように入力して

ください。 

⑧ 入力後、Method Wizard の画面で Finish

をクリックして終了します。 

⑨ 作成に成功すると、The method IDA 

was successfully saved.のメッセージが表

示されますので、OKをクリックして

終了します。 

 

1 Cycle の測定時間 

(自動計算) 

Tips: Cycle Time を見なが

ら、MS/MS の数と積算時

間を調整します。 

同じイオンを繰り返し選択させ

ないための設定。  

For: 選択後、指定した時間の

間、同じイオンを選択しない。 

同じイオンを繰り返し選択させる

ための設定 

Include List: 

必ず MS/MS を行いたい m/z 

Exclude List:  

MS/MS の測定対象から除外し

たい m/z 

（備考 1 を参考ください。） 

MS/MS の CE 

MS/MS の測定範囲 

親イオンの測定範囲 

測定時間 

1 サイクルで測定する

MS/MS の数 

最大数： 

TripleTOF 6600+:  100 

TripleTOF 5600+:  100 

TripleTOF 4600:      50 

Scheduled Ionization を

使用する場合は、チェ

ックを入れ、Start にイ

オンの取り込み開始時

間、Stop に測定終了時

間を入力します。 

* チェックを入れた場

合、Mass Spec 

Acquisition Duration は

Stop に設定した時間に

なります。 

親イオンの積算時間 

各MS/MSの積算時間: 

最小 10msec、CES 使

用時の推奨 : 25msec

以上 

Mass Defect Filter (備考 3 を参考ください。) 

(Negative: -4500) 
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 Inclusion List, Exclusion List 

必ず MS/MSを行いたい m/z、MS/MSの測定対象か

ら除外したい m/zがある場合に使用します。 

 チェックをかけ、Detailsをクリックします。 

 起動した右の画面で、Importをクリックし、Text

形式で保存した ListFileを開く、あるいは目的の

Mass, RTを入力します。 

 画面下に RTの Toleranee、Ion強度の閾値を入力

し Closeします。 

* RT は以下の備考 2をご参考ください。 

 

 SMART Filter（IDA – Specific Mass And 

Retention Time Filter） 

Analystでの測定 Method作成時の RT の設定方法になります。 

・ 正の値：入力した時間を基準に window (For: ~ sec)で設定した時間 

・ ０：全測定時間 

・ 負の値：測定開始から入力した時間 

*  

 

 

 

 

 

 

 Mass Defect Filter 

主に薬物の代謝物同定や、類縁体の

分析、低分子ペプチドの分析時に使

用します。 

* 薬物代謝物同定用の詳細な Manual

を別途用意していますので、必要

な方はご請求ください。 

 Mass Defect Filterに checkをかけ、

Detailsをクリックします。 

 起動した右の画面で、Peptideあるい

は Metabolismを選択します。 

 Metabolismを選択した場合、Importをクリックし、Text形式で保存した ListFile

を開く、あるいは目的の情報を入力します。 

 必要に応じて、Exclusivelyにチェックをかけ、Closeで終了します。 

Check: 入力したDefectの設定条件に一致する

イオンだけを MS/MS へ選択 
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 Method の確認、修正 -1 IDA 

 Navigation Barの Acquireをクリックし、File  ->  Open から目的の Method

（Trainingでは IDA）を選択します。 

 Acquisition Methodを右クリックし、Add/Remove Device Method で使用するデバ

イスのみにチェックをかけ、OKをクリックします。 

* 内蔵の Syringe Pump が必要ない場合は、必ずチェックを外してください。

Trainingではチェックを外してください。 

 Synchronization Modeを LC Sync に変更します。 

 

 

 

 

 

 

 

 Acquisition Method の TOF MSをクリックし、親イオンの測定条件の確認、必要

に応じて変更を行います。 

* Trainingでは変更しません。 

* Gas など、Parameter の変更の際には Edit Parameters をクリックして、Parameter 

Settings画面を開き、確認、変更ください。変更した場合、Product Ion も同条件

を反映するには Apply the following…の Source/Gasにチェックを入れることで、

反映されます。 

* Scheduled Ionization を使用する場合、Stop Time が Duration（測定時間）になり

ます。 

  

No Sync：同期を行いません。 

Manual Sync：ユーザが同期を行ないます。 

Manual Sync with Valve：内蔵のバルブをインジェクタ

として使用します。 

Injection Manifold Sync：Injection 用 の Module が

Injection Positionに動いた際に Startします。 

LC Sync：LC またはその他の外部の装置と同期を行な

います。 

④ 
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 Product Ion (+) IDA をクリックします。 

 

 

 

 

 

 

 

 

 

 MS タブで High Resolution / High Sensitive の確認、変更を行います。 

* Trainingでは、MS タブで、High Sensitivityに変更してください。 

 Edit Parametersから Parameter Settings画面を開きます。 

 CES に目的の値(Trainingでは 15)を入力します。 

* Rolling Collision Energy（備考参照）を使用する場合、IDA Advanced Tab で

Rolling Collision Energy にチェックをかけ使用してください。Training では使用

しません。 

 必要に応じて、Advance MSタブで Q1 の分解能を変更します。 

* Trainingでは変更しません。 

 必要に応じて、Switch Criteriaのタブをクリックし、設定を変更します。 

* Trainingでは変更しません。 

 

MS/MS を測定する親イオンの強度の最小値 

選択したピークについて同位体として除外する範囲(+-の値) 

同じイオンを繰り返し選択させないための設定 

・ Never: 常に取り続ける 

・ Always: １度選択した後、選択しない（主に Infusion で使用） 

・ For: 選択後、指定した時間の間、同じ親イオンを選択しない。 

・ After # occurrence(s): 入力した回数だけ同じ親イオンを選択 

MS/MS を測定する親イオンの m/z の範囲 

選択したピークについて同じイオンとする誤差範

囲 

1 サイクルに MS/MS を測定する数 

MS/MS を測定する親イオンの価数 

⑥ 

⑤ 

⑦ 

⑧ 
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 必要に応じて、Include/Excludeタブをクリックし、Include Listあるいは Exclude 

Listを編集します。 

* 詳細は 27 頁を参照ください。 

* Training では使用しませ

ん。 

 必要に応じて、IDA 

Advanced タブで、設定を変

更します。 

* Rolling Collision Energy

（下記参照）を使用する

場合、IDA  Advanced Tab

で Rolling Collision Energy

にチェックをかけます。

Training では使用しませ

ん。 

 Fileから Save を選択し、保

存します。 

 

 

【 Rolling Collision Energy について】 

￭ チェックをかけることで、観測されたイオン

の m/z、価数に応じて Script Menu の IDA CE 

Parametersの計算式でCEが計算、使用されま

す。 

￭ 計算に使用する最適な Slope、Interceptは化合

物の構造などによって異なりますので必要に

応じて設定を変更して下さい。設定方法の詳

細につきましては、英文マニュアルをご参考

ください。 

  

目的の情報を入力 

* Training では入力しません。 

使用する際にチェック 

* Training では使用しません。 

 

チェック: 

下に入力した Defect の設定に

入るものだけを選択 

目的の同位体分布を指定する場合

にチェック、Match isotopesを選択

し、以下に同位体パターンを入力 

* Training では使用しません。 

Rolling Collision Energy (下図参照) 

* Training では使用しません。 

 

Dynamic background subtract 

(DBS) 
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 LC 条件の入力、修正 -1 島津社製 HPLC、PDAなしの場合 

 

* 島津社製の HPLC を使用した場合を示します。他の

LC をご利用の場合は、93 ページ以降を参考くださ

い。 

* PDA を使用する場合、Shimadzu’s AAO Module for 

Enhanced Analyst® HPLC Control （旧名称 MIMIC）

から設定を行います。“ LC条件の追加、修正 -2 島

津社製 HPLC、PDAあり”の項を参照ください。 

 Acquisition Methodを右クリックし、Add/Remove 

Device Method で使用するデバイスのみにチェックを

かけ、OKをクリックします。 

* 内蔵の Syringe Pump が必要ない場合は、必ずチェッ

クを外してください。Training ではチェックを外し

てください。 

② Synchronization Modeを LC Sync に変更します。 

 

 

 

 

 

 

 

③ Shimadzu LC Systemをクリックします。 

④ Autosamplerのタブをクリックし、必要に応じて Rinsing Dip Time、Rinse 

Mode、Cooler Temperature などを入力します。 

* Trainingでは以下のように設定してください。 

 

 

 

 

 

 

 

 

 

 

 

No Sync：同期を行いません。 

Manual Sync：ユーザが同期を行ないます。 

Manual Sync with Valve：内蔵のバルブをインジェクタ

として使用します。 

Injection Manifold Sync：Injection 用 の Module が

Injection Positionに動いた際に Startします。 

LC Sync：LC またはその他の外部の装置と同期を行な

います。 

Rinse Pump が導入されている場合 

表示されます。 
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⑤ Ovenのタブをクリックし、必要に応じて Enable Ovenにチェックをかけ、温度

を設定してください。 

* Trainingでは 40℃に設定してください。 

⑥ Pumpsのタブでポンプの設定を行います。 

* Trainingでは、Pumping ModeにBinary Flowを選択し、以下のように流速、Pump 

Bの初期値、Pressure Limitsを入力してください。 

 

 

 

 

 

 

 

 

 

 

⑦ Time Programのタブをクリックし、グラジエントの条件を入力、MSの測定時

間を確認します。 

* Trainingでは、以下のように設定してください。 

* グラジエントの最後には必ず Controller Stopを入力して下さい。 

* 入力後、Update Graphをクリックすることで、Tableが時間順にソートされ、下

図のグラフが updateされます。 

* MS の測定時間を変更する場合は、Mass Spectrometerをクリックし、Durationに

適当な値を入力してください。 

 

 

 

 

 

 

  

1 
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⑧ Detector A のタブをクリックし、UVの設定を行い、Run Timeに測定時間を入力

します。 

* Run Time は必ず

Time Program内

の時間 

(Controller Stop

以下の時間) で

設定してくださ

い。 

* Trainingでは右

図のように入力

してください。 

 

 

 

 

⑨ Injection をクリックし

Injection Volume を入力し

ます。 

* Training では 5 を入力し

てください。 

⑩ Menu Barの Fileから Saveを選択し、Methodを保存します。 

  

Run Timeは必ず Time Program内

の時間 (Controller: Stop以下の時

間) で設定ください。 
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 LC 条件の入力、修正 -2 島津社製 HPLC、PDAありの場合 

 

* Shimadzu’s AAO Module for Enhanced Analyst® HPLC Control （旧名称 MIMIC）

から設定を行います。 

* PDA を使用しない場合、LC 条件の追加、修正 -1 島津社製 HPLC、PDA なし

の場合を参照ください。 

 Navigation Barの Shimadzu Instrument driver

をダブルクリックし、Shimadzu HPLC 

Control画面を立ち上げ、Set Upをダブルク

リックします。 

 Methodの選択画面で、目的の Method

（Trainingでは IDA）を選択して開きます。 

 Autosamplerのタブをクリックし、必要に応

じて Rinsing Dip Time、Rinse Mode、Cooler 

Temperature などを変更します。 

* Training では右図のように設定してくださ

い。 

 

 Ovenのタブをクリックし、必要に応じて

Enable Ovenにチェ

ックをかけ、温度を

設定します。 

* Training では使用

しません。 

 

 

 Pumpsのタブでポンプの設定を行います。 

* Training では、Pumping Mode

に Binary Flow を選択し、右図

のように流速、Pump B の初期

値、Pressure Limits を入力して

ください。 
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 Time Programのタブをクリック

し、グラジエントの条件を入

力し、入力後、MSの測定時間

の確認を行います。 

* Training では右図のように入

力してください。 

* グラジエントの最後には必

ず Controller Stop を入力して

下さい。 

* 入力後、Update Graphをクリ

ックすることで、Table が時

間順にソートされ、下図の

グラフが updateされます。 

* MS の測定時間を変更する場

合は、Mass Spectrometerをク

リックし、Duration に適当な

値を入力してください。 

 

 

 PDA-Generalのタブをクリックし、UVの設定を行い、Run Timeに測定時間を

入力します。 

 

* Channelを選択し

Wavelength を入力します。 

* Trainingでは右図のように

入力してください。 

* Run Time は必ず Time 

Program内の時間 

(Controller: Stop以下の時

間) で設定ください。 

 

 PDA-DA Outputのタブをクリ

ックし、目的の波長を入力し

ます。 

 Fileから Save を選択し、

methodに LC の条件を上書き

します。 

 Fileから Exitを選択し、画面

を終了します。 

※ Injection Volume は Batch

作成時に設定します。 

Run Time は 必 ず Time Program 内 の 時 間 

(Controller: Stop以下の時間) で設定ください。 
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 Method の作成 -2 TOF MS-MS/MS （定量用） 

 Navigation Barの Method Wizard をダブルクリックします。 

 Choose Methods タブの Choose MS Method で TOF MS + Product Ion /  TOF MS + 

Hi Sensitivuty Product Ionなど、目的の Templateを選択します。 

* Trainingでは以下のように選択してください。 

TripleTOF® 4600:  ToF MS + Product Ion (+) 

TripleTOF® 6600, 5600+ :  ToF MS + Hi Sensitivity Product Ion (+) 

 Choose LC Methodで Browse…から目的の LC 条件を選択します。作成済みの

LC 条件がない場合は、スキップします。 

* Trainingでは IDAを選択してください。 

 

 Save Method AS: で保存する File名(Trainingでは TOF_PI)を入力後、Enterしま

す。 

 Nextをクリックします。 

 Ion Source Parameters タブで適当な parameterを入力し、Nextをクリックしま

す。 

* 以下の Table を参考に入力します。高感度化が必要な場合は、別途最適化し、

最適値を入力してください。 

※ Trainingでは標準の数値の以下を入力してください。 

Curtain Gas (CUR):   25 

Ion Source Gas1 (GS1):   50 

Ion Source Gas2 (GS2):  50 

IonSpray Voltage Floating (ISVF)  

・Positive:   5500 

・Negative:   -4500 

Temperature (TEM):  550 

 

 

 

 

  

TripleTOF®4600 System TripleTOF®6600, 5600+ 

System 
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 TOF MS – MS/MS タブで parameterおよび目的の親イオン、CE、CES の値を入

力し、Finishをクリックして保存します。 

※ Trainingでは下図のように入力してください。 

 

 

 必要に応じて、Methodの確認、修正、LC 条件の修正、測定の準備を行ってく

ださい。 

* Trainingでは行いません。 

 Batchを作成し、測定を行います。 

* Trainingでは測定しません。 

 

親イオンの測定レンジ 

親イオンの積算時間 

MS/MS の測定レンジ 

各 MS/MS の積算時間 

測定時間 

1 Cycle の測定時間 

(自動計算) 

親イオン、CE、CES

の順に入力。 

Copy/Paste 可能 

0.05 

Tips: Cycle Time を見な

がら、MS/MS の数と積

算時間を調整します。 
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 測定の準備 

 装置の平衡化します。Tool Barの      をクリックし Q Managerの画面を開き､次

に Tool Barの     をクリックしてく

ださい。 

 右下のアイコン        が緑色の場合は    

をクリックし、黄色にした後                

をクリックしてください。 

 Equilibrateの画面で、使用する

Method（Trainingでは IDA.dam）、平

衡化時間（Training では 1）を選択し

OKをクリックします。 

 Exsion LC 使用の場合、画面右下の  をダブルクリックし、開いた Windowで

初期条件を入力し、Readyにします。   

 LC の溶媒が流れ、ガスやターボガスの加熱が始まります。1分後に画面右下の

MS などの表示が黄色から緑色に変わります。 

 

 Batch の作成 

 Navigation Barの Build Acquisition Batch をダ

ブルクリックします。 

 Add Set、Add Sample の順にクリックしま

す。 

 New samplesに測定するサンプルの数を入

力し（Training では１）、OKをクリックし

ます。 

 表が作成されますので Sample Name、Data File を入力します。 

※ Trainingではそれぞれ Mix、IDAと入力してください。 

* 複数データを取得する場合、Data File 名は同じにせず別名で保存してください。

同一名で保存し、データファイルのサイズが 2GBを超えた場合、解析ができな

い場合があります。 

⑥ 

④ ④ ⑤ 

⑥ 

⑦ 
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* 特殊文字 (スペース+ - * . ,@ # % & ^()など)の使用は推奨していません。Software

によって Dataが開かないなど、不具合が起きる場合があります。使用されない

ことを強く推奨します。以下にも類似の例がありますのでご参照ください。

  

https://support.microsoft.com/ja-jp/kb/826763 

* File名以外は測定後変更ができません。 

* Batch 上で右クリックし、Hide/Show から Comment にチェックすることで、

Comment カラムが表示され、カラムや溶媒などの情報を入力、保存することが

できます。入力した内容は測定後変更できませんのでご注意ください。 

 Rack Codeが使用しているラックであることを確認し、Vial Positionに sampleの

ポジションを入力します。 

 Acquisitionの Method Editorのプルダウンから、作成した Method（Trainingでは

IDA）を選択します。 

* サンプルごとに測定 Method を変更する場合は、Use Multiple Methods にチェッ

クをかけ、Acquisition Method のカラムを表示させます。表示させたカラムで

個々に Method を選択してください。 

 Shimadzu’s AAO Module for Enhanced Analyst® HPLC Controlを使用している場合

（PDA 使用の場合）は、Injection量を入力します。 

* 他の LC については、Acquisition Method 内で指定した数値が反映されます。カ

ラム内の Injection Volume を変更することで、Injection 量を変更することも可能

です。 

 必要に応じて、Calibrateのタブ

で、Auto Calibration にチェックを

かけ、条件を入力、設定します。 

*  Trainingでは

右図のよう

に入力、選

択してくだ

さい。 

 

 

 

 

 

 

* Auto Calibration の平衡化では、自

動で Refillの動作を行います。 

* バッチの途中で CDS 溶液のボトルが切り替わる際には、自動で Purge の動作を

行います。 

⑨ 必要に応じて File  ->  Save As…から Batch を保存します。 

* Trainingでは File Name: IDAで保存してください。  

何サンプルに１回 Calibration を行うか

の設定 

* 連続分析の際は数時間おきに 1 回入る

よう設定します。 

50uL/min～500uL/min 程度、装置、測

定条件 LC 溶媒、流速、MS のレンジな

どで異なります。 

 

使用する Calibration File 

View から内容を確認し、8 頁を参考に

適切な File を選択してください。 
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 Batch を使用した測定 

 サンプルを Vial Positionで入力したポジションにセットします。 

 Submitのタブをクリックし、Submitボタンをクリックします。 

* 連続分析中はこの操作で、Submitした順に自動で測定が行われます。 

 

③ 状況を確認する場合は、Tool Barの  をクリックし Q Managerを表示します。 

④ 上記のように   で待機している場合は、Tool Bar の   のアイコンをクリ

ックして、  に切り替え後、Tool Bar の   (Start Sample)をクリックして

Calibration、測定を開始してくだい。 

* この際 Do you want to…のエラーメッセージが表示されます。Tune Modeで使用

していた Method を保存する場合は Yes で保存、必要のない場合は No でメッセ

ージを抜けてください。 

* Trainingでは Noを選択してください。 

* Calibration は、CDS が必要な Refill を行った後開始します。2 分程度かかります。 

* Calの左に緑のチェックが入り、成功したことを確認してください。 

* 赤×の場合は Calibration に失敗しています。トラブル対応の項を参考ください。 

* 測定中の Data は Analyst の Explore Modeで確認することができます。リアルタ

イムのスペクトルを表示させるには TIC 上で表示が進んでいるクロマトグラム

の先端よりも先の部分（まだ表示がされていない部分）にカーソルを持ってい

きダブルクリックしてください。 

 

 測定の終了 

 Navigation Barの Acquireをクリック後、Tool Barの     ,      の順にクリッ

クして装置を Standbyにします。 

 LC の接続を外します。 

 必要に応じて「2.5測定の終了、流路の洗浄」を参考に Tune Mode で流路を洗

浄してください 

 

 

Q Manager 

Calibration の Run 

Submit した Run 
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データ解析   

（LC-MS, PeakView® Software） 

5 データ解析（LC-MS, PeakView® Software） 
 

【 データの表示方法について】 

￭ TIC から、IDA Explore からの 2種類の Data の開き方があります。 

￭ IDA Explorerは IDAで取得したData用の解析手法になります。SWATHなど、他の測定

方法については、対応していません。 

￭ どちらの方法からも他の解析画面を開くことができます。 

A.   TICからの解析の初期画面 

  

 

 

 

 

 

 

 

 

 

 

 

B.   IDA Explore からの解析の初期画面 

 

 

 

 

 

 

 

 

 

 

 

 

￭ 複数の Dataを同時に解析する(Open Multiple Wiff Samples…)、File名や File内の Sample 

Nameや Sample Info.から目的のデータファイルを検索する (Find Wiff Samples)ことも可

能です。 

￭ PeakView® Software の詳細な説明につきましては、ユーザーマニュアル（日本文、英

文）、Reference Guide (英文) を参考ください。 

￭ 英文の資料につきましては、PeakView® Software の Help から参照することが可能です。 

* すべての測定法方法

に対応しています。 

 * 初期画面は使用した

全測定 Methodの TICの

重ね書きになります。 

 

* IDAで取得した Data

用の解析手法になりま

す。 

* スペクトルの確認か

ら構造解析、類縁体検

索など、様々な解析を

容易に行うことができ

ます。 
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 PeakView® Software の起動 

Analystの Navigation Barの PeakView® 2.2、あるい

は、Desktop のショートカットをダブルクリックし、

PeakView® Software を立ち上げます。 

 

 TIC からの解析 

 Tool Barの   アイコンあるいは File Menuの Open Wiff Sample…から目的の

Fileを選択します。 

* Training で は TT_Training Project の

01_Training フォルダ内の IDA_withUV を

選択してください。 

 TIC から開く(As a standard TIC)を選択し、

OKをクリックします。 

* MSと MS/MSの TICの重ね書きが表示さ

れます。 

 

  

TIC の重ね書き 
   MS 
      MS/MS 
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 UV/ DAD / アナログ Data の表示とアライメント 

 Tool Barの Showから目的の表示を選択することで表示されます。 

 

* Dataにより画面が変わります。 

* Trainingの Dataは UV の Dataになります。UV/DAD/ADC Channelを選択してく

ださい。 

  表示されたクロマトグラム (Trainingでは

UV/DAD/ADC Channel)を選択(画面をクリッ

ク)し、Tool Barの Processから Offset 

Chromatogramを選択し、Offset画面（右）で

溶出時間のずれ(例では 0.06分) の数値を入

力します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

② UV/DAD/ADC 

(0.06 分 Offset 後) 
① UV/DAD/ADC 

Channel 

TIC の重ね書き 
   MS 
      MS/MS 

この差が溶出時間

のずれ（Offset 値） 

TIC の重ね書き 
   MS 
      MS/MS 

DAD の場合 UV / DAD / アナログ Data の場合 

TWC 

(Offset 前) 
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【 DAD の Data からの UV スペクトルの確認についてと注意】 

* DAD で取得した Data からは UV ス

ペクトルを確認することができま

す。 

* Offsetを行っていない TWCあるいは

XWC 上で目的の Peak をダブル  

クリックすることで UV スペクトル

が表示されます。 

* 必 要 に 応 じ て 、MS と 同 様 に

Background を引くなどの解析を行っ

てください。 

 

* 右のDataは TrainingのDataと異なり

ます。 

 

 

 

 Pane を隠す、削除する、全画面にする、拡大する 

 目的の Pane を選択後、画面上部にある Tool Bar  から目的の

アイコン（左から、削除する、全画面表示する、選択した Paneを隠す、選択し

た Pane以外を削除する）を選択してください。 

 拡大する時は軸のエリアをドラッグ、全範囲に戻る場合は軸のエリアをダブル

クリックします。 

* Training では UV を隠し、TIC のみにした後、以下のように、3 分付近を拡大し

てください。 

 

 

 

  

拡大する時は軸のエリアをドラッグします。 

全範囲に戻る場合は軸のエリアをダブルクリックします。 

TIC の重ね書きの拡大 
    MS 
        MS/MS 

RT2.36 分の UV

スペクトル 
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 スペクトルの表示 

* IDAの Data について、クロマトグラムからの解析には 2種類あります。 

i. 重ね書きする：Overlay spectra… 

選択した時間内の IDA のサイク

ルに含まれる MS/MSがすべて

重ね書きで表示されます。異な

る時間に測定された同じ

Experimentのスペクトルが平均

される可能性がありますので、

範囲指定はせず、1点で解析く

ださい。 

ii. 重ね書きしない：Use one spectrum… 

MS 上で、MS/MS取得済みの Parkが赤でハイライトされます。目的の Peak

をクリックすることで、その MS/MSが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 目的のクロマトグラム上の目的の時間あるいは範囲を選択、ダブルクリックし

ます。 

* Trainingでは下図を参考にTIC上の

適当な範囲を選択、ダブルクリッ

クしてください。 

 右の画面が表示されますので、目的

の表示を選択、OKします。 

* Trainingでは Use…を選択してくだ

さい。 

* 画面下に  の表示がないクロマ

トグラムから解析を行った場合

は、右の画面は表示されません。 

ii. MS（赤：MS/MS 取得済み） i. MS 

MS/ MS の重ね書き 選択した Peak の MS/MS 

i  

ii  
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 表示された MS 上で目的の Peak をクリックして MS/MSを表示します。 

* 以下では m/z 233の MS/MSを表示しています。適当な Peakをクリックして 

確認してください。 

* 赤のハイライトを消した MSが必要な場合は、MSを選択（クリック）し、Tool 

Barの Graph から Duplicate Graphを選択することで、ハイライトのない MSが

複製されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 スペクトルからのマスクロマトグラム(XIC)の表示 

* Trainingでは MS/MSを削除してください。 

  MS上で目的のイオンを選択、ダブルクリックすると XIC が表示されます。 

* 以下では m/z 465 の XIC を表示しています。適当なイオンをダブルクリックし

て確認してください。 

 

MS（赤：MS/MS 取得済） 

み） 

選択した Peak (m/z 233)の MS/MS 

① 
MS の拡大 

み） 

m/z 465.2503 の XIC 
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 Background の指定、差引 

 Backgroundに指定する部分

を選択します。 

* 2 か所選択する場合はシフ

トキーを押しながら選択

してください。 

 選択後、画面上部の    

をクリックすることで、ハ

イライトがブルーからピン

クに変わります。 

* 以降の解析で Background

として解析するスペクトルから差し引かれます。 

 

 クロマトグラムからのマスクロマトグラム (XIC) の表示、ラベル、ハイライ

ト 

* Trainingでは MS、XICを削除し、TIC のみ表示させてください。 

 Tool Barの Showから Extracted Ion 

Chromatogram (XIC)を選択します。 

 Select Experiment画面で目的の測定

（Trainingでは 1番上の TOF MS）を選

択し、OKをクリックします。 

* Precursor Ion （親イオン）の場合は 1

番上の TOF MS を選択します。 

* 画面下に  の表示がないクロマトグ

ラムから解析を行った場合は、右の画

面は表示されません。 

 入力画面で目的の組成式あるいは m/z、

Width (Da)、化合物名を入力します。 

* 組成式を入力した場合、自動で

Positive: [M+H]+, Negative: [M-H]-が計算

されます。 

* Training では右のように入力してくだ

さい。 

 OKをクリックすることで、XICが重ね

書き表示されます。 

 XIC 上部の  アイコンをクリックすることで、各 XICの Peakに化合物名が

表示されます。 
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 XIC 上部の  アイコンをクリックすることで、選択した XIC （タイトルが太

字で表記されているもの）が塗りつぶされます。 

 

 軸のリンク 

 軸のリンクを行いたいクロマトグラム上部の  アイコンをクリックすること

で、X軸がリンクされます。 

 Y軸をリンクする場合は、   アイコンの右側の▼から Link Y-Axesを選択

してください。 

 

TIC の重ね書きの拡大 
    MS 
       MS/MS 

XIC の重ね書き 

⑤ ⑥ 

X, Y 軸をリンク、拡大した例 TIC の重ね書きの拡大 

    MS 
       MS/MS 

XIC の重ね書きの拡大 
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Melatonin Melatonin  
+O 

Melatonin  
+2O 

XIC の重ね書き 
     Melatonin 
     Melatonin+O 
     Melatonin+2O 

 

 重ね書きした Pane（クロマトグラム、スペクトル）の分離 

 目的の Pane（Trainingでは XICの重ね書き）を

選択します。 

 Tool Barの Graphから Split Traces into Separate 

Panesを選択します。 

 Number of Columnsの画面で、分割後横に並べる

Paneの数 （Trainingでは 3）を指定します。 

 OKをクリックすることで、分割されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 画面のコピー 

 目的の Pane を選択します。 

 Tool Barから、Edit を選択し、以下を参考に目的の Copyの種類を選択します。 

• Copy: 選択した Paneの Data（画像、リスト）を Copyします。 

• Copy Graph：選択した Paneの画像を Copyします。 

• Copy Window：選択した Painを含む Window全体を Copyします。 

* ペイントや potファイル等にペースト可能です。 

* Trainingでは行いません。 
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 IDA Explorer からの解析 

IDA で取得した Data について、スペクトルの確認から構造解析、類縁体検索など、

様々な解析を容易に行うことができます。 

 Tool Barの   アイコンあるいは File 

Menuの Open Wiff Sample…から目的の File

を選択します。 

* Trainingでは、Trainingで測定した IDAあ

る い は 、TT_Training Project の

01_Trainingフォルダ内の STDmix_IDAを

選択してください。 

 With the IDA Explorerを選択し、OKをクリ

ックします。 

* 以下の形式の初期画面が開きます。 

 

 

  
取得済みの MS/MS の数 

横軸：RT 

選択した点

の MS/MS 

各点: MS/MS 取得済みの

Precursor Ion （親イオン）

の m/z / Retention Time (RT) 

縦軸：m/z 

指定の Tolerance で Merge 後の取得済みの MS/MS の数 

（設定については以降を参照ください。） 
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5.12.1 縦軸の切り替え、リスト表示 

目的に応じ、Graphの縦軸を切り替える、リスト表示にすることが可能です。 

 

縦軸の切り替え 

画面上を右クリックし、

Graph Y-Axisから目的の

縦軸を選択します。 

* Fragment Match TIC は

後述の Fragment Matching使用時に使用できます。 

* Trainingでは②Dependent TIC（強度）に変更してください。 

 

5.12.2 Table表示 

画面上部の Table Tabを選択することで

表示されます。 

* Trainingでは Graphの Tabをクリック

し、②Dependent TIC（強度）にして

ください。 

* Tableの各項目をクリックすることで

ソートすることができます。 

縦軸： 

① Precursor Mass/Charge 

m/z 

② Dependent TIC 

強度 

③ Fragment Match TIC 

Match した Fragmentの強度 

① 

② 
③ 

Table の項目名を 

クリックすることで、

ソートされます。 
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5.12.3  スペクトルの統合（Merge） 

* 指定の m/z, RTの Tolerance内の Peakについて、積算して表示します。 

* 解析が容易になり、より質のよい MS/MSが得られる可能性があります。 

* 前の解析時の設定が保存されます。LC 条件の変更後など、必要に応じて確認

してください。 

 画面左上の  アイコンで Options（右下）を開きます。 

 Merge…にチェックをかけ、Mass, RT gap 

Toleranceに適当な値を入力します。 

* RTの Toleranceは LCの Peak幅に依存し

ます。 

* Trainingではそれぞれ 10, 0.1を入力して

ください。    

 

 

  

 

 

 

 

 

 

 

 

 

 
 

 

取得済みの MS/MS の数 

Merge 前 Merge 後 

Merge 後の MS/MS の数 
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5.12.4 Filtering 

* MS/MS 取得された Precursor Ion に Filter をかけ、目的のイオンを抽出し、解析

を容易にすることが可能です。 

* 設定できない項目（グレイ表示）については、別途設定が必要になります。 

 画面左上の Filtering Controlの左の +  をクリックし、画面を開きます。 

 次ページを参考に   を左ドラッグで移動、あるいはダブルクリック後数値

を入力し、目的の制限をかけます。 

* Trainingでは以下のように、m/zを 600～650に制限してください。 

* 終了後、Filtering Control左の  -   から Filtering Controlは閉じてください。 

 

 

Filter 後 

Merge 後の MS/MS の

数 

Filter 後、Filter 前の MS/MS の数 
 

Filter 前 

600 650 
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【 Filtering Controlsについて】 

* 以下の Filterが可能です。 

* *については、別途設定が必要な項目になります。 

 

• Retention Time (RT)  

• m/z 

• TIC: Fragment Ion の強度の積算 

• Quality (%): 親イオン、ノイズを除く Fragment Ion の強度の積算の全 Fragment 

Ionの強度の積算に対する比率 

• Matched Int (%)*: 設定した Fragment Ion, Neutral Lossに一致した Ionの強度の

Precursor Ion, Background Ion を除く全 Product Ion中の比率（Fragment Matching

の項を参照ください。） 

• Similarity (%)*: 設定した基準化合物と一致する Fragment Ion, Neutral Lossの

Precursor Ion, Background Ion を除く全 Product Ion中の比率 

• Mass Defect  

• Defect in Range*: 設定（複数可能）した Defect内の Precursor Ion のみを表示 

• Isotope Pattern*: 設定（複数可能）した同位体比を持つ Precursor Ion のみを表示 

 

 

 

5.12.5 IDA Explorer を用いた目的物質の MS, MS/MS, XICの表示 

* Trainingでは Reserpine (m/z 609.2807, C33H40N2O9+) について解析を行います。 

 目的の Peak をクリックします。 

* Trainingでは m/z 609.28をクリックしてください。 

* 右側に選択した Peakの MS/MSが表示されます。 

 

  

MS/MS 
of  609 
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② 画面左上の      （左から MS, XIC, MS/MS）から MS, XICをクリック

して表示します。  

5.12.6 Paneの移動、横軸のリンク、足し合わせ、差し引き、重ね書き 

 各 Pane右上にあるアイコン（上から、移動、足し合わせ、差し引き、重ね書

き）から目的のアイコンをクリック＆ドラッグしてください。 

* Trainingでは   を使用し、以下のように画面を移動してください。 

  

MS 

MS/MS 

XIC 

MS/MS 

XIC 

MS 

① 
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 組成解析 (Formula Finder ) 

* MS の精密質量、同位体分布、および MS/MSから組成解析、フラグメントイオ

ンの帰属を行う機能です。 

 前述を参考に組成分析を行うピークの MSおよび MS/MSを表示します。 

 Trainingでは、IDA Explorer、XICの Paneを削除し、MS、MS/MS のみを表示さ

せてください。 

* m/zのラベル表示されていないピークは、以降の解析で数値が読み込まれませ

ん。必要に応じて、スペクトルの Y軸上で、Label Threshold➡を動かし、目的

のピークをラベルしてください。 

 MS 上で、目的のピークについて同位体を含めて左ドラッグし、ピークを選択

します。 

 Tool Barの Show から Formula Finderを選択し、Formula Finder を開きます。 

 Formula Finder の右端にある   ボタンを MS/MS上にドラッグ&ドロップし

て、Formula Finderと MS/MSをリンクします。 

  

Formula Finder 

⑤ 

③ 

⑥ 

MS/MS MS 

⑦ 

⑧ 
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 必要に応じて、Isotope Cluster detailsで

組成分析に使用しない同位体の Use のチ

ェックを外します。 

* 他のイオンが重なっている Peak な

ど、必要に応じて外してください。 

* Trainingでは外しません。 

 MS の解析条件を入力します。 

* Training では右図のように入力、設定

を行ってください。 

 MS/MSの解析条件を設定します。

Formula Finder の右画面を MSMS Details 

Tabに切り替え、Mass Tolerance, #C / 

#heteroatomsに適当な値を入力します。 

* Trainingでは下図のように入力し、MS Details Tabに戻ってください。 

 Findをクリックすることで検索結果が表示されます。 

* Find any ボタンを押すと、設定した検索条件に合致しない結果も表示されます。 

 

 

【 各設定について】 

￭ Elements from, to: 検索する元素とその元素数の下限、上限 

* 入力した元素、元素数の範囲内で検索が行われます。 

￭ Mass tolerance:  

* 初期値として MS では 5ppm、MS/MS では 5mDa を推奨します。他のイオンが

重なっている、強度が弱いなどの場合は大きく設定してください。 

￭ Intensity Tolerance (%): 

* 初期値として 5～10%を推奨します。他のイオンが重なっている、強度が弱い

などの場合は大きく設定してください。 

￭ #C / #heteroatoms…: 炭素とヘテロ元素の比の制限 

* 一般的な化合物では MS では 1、MS/MS では 0 を推奨します。未知成分で不明

な場合は MSについても 0を推奨します。 

 

⑥ 

⑦ 

⑨ 

⑧ 

⑧ 
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解析結果について 

解析結果は組成式のリストおよび 3 つの Tab（MS Details､ MSMS Details､Compound 

Details）で表示されます。 

Found Elemental Compositions 

 

 

 

 

 

 

 

 

 

 

 

 

 

MS Details: MS の帰属結果 

 

 

 

 

 

MSMS Details :MS/MS の帰属結果 

 

 

 

 

 

 

 

MS 情報（精密質量と同

位体分布）から組成解析

結果の ランキング 

Hit した組成、m/z の理論値不

飽和度（RDB）、MS の誤差 
MS/MS の誤差（強度の加重平均値） 

（ ）内：使用した MS/MS の Peak 数   

（スペクトル上で数値表記された Peak

） 
 

MS/MS からのランク 

Database 検索の Hit 数 
 (Local Library / ChemSpider) 

グラフコピー、テーブルの

コピー、レジェンドの表示 

MS, MS/MS の情報か

ら総合ランク* 

組成解析結果 

検索されたすべての組成の範囲内の組成解析結果 

（All の右の▼から表示変更可） 

緑、オレンジ：左のリストで選択した組成     （例

：C33H49N2O9）で可能性がある Product Ion の組成 

緑：上記中、error の最も小さい組成 

グレー：選択した組成では帰属できない組成 

白抜き：ラジカル 

ひし形：クリックして選択した Product Ion の組成

から関連する組成 

   実測 

      計算上の分布 

検出された他の

付加体の情報 
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Tips: Product Ion の情報を用いた組成解析の確認 

* 不正解な組成の可能性

の高い例 

 

 

 

 

 

 

 

 

 

 

 

 

 

Compound Details :Database 検索の結果 

* 設定した Localライブラリ、あるいはOn-lineのChemSpiderサーチの結果です。 

* ChemSpiderの使用には別途有償ライセンスとWebへの接続が必要になります。 

* 使用するデータベースの確認、設定、変更については次ページの備考を参照く

ださい。 

 

 

 

 

 

左から 

• mol file 形式の構造式の保存 

• ChemSpider のウェブサイトへのリンク 

• コピー 

• 検索された化合物の一覧表示 
検索された化合物リスト 

左のリストで選択した化合物の構造 

* 主要な Product Ion が帰属されていない 

* 帰属された Ion が少ない 

などから、組成が間違っている可能性が高い 
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【 Formula Finderの詳細設定（Options）について】 

* 解析の条件変更、Databaseの変更など、必要に応じて確認、変更を行います。 

* Formula Finder ウィンドウ左上の   ボタンをクリック、Options画面を開き、

必要な設定を変更後、画面下の OKをクリックし終了してください。 

* 以下 Training時の設定になります。 

  

Result Summary Tab 

Dictionaries Tab 

Elemental Composition Tab 

-1.0 
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Elemental Composition Tab:組成解析の設定 

￭ RDB from, to: 不飽和度の下限、上限 

* 必要に応じて変更してください。 

￭ Oxygen count / Phosphorous count, Sulfur Count: 酸素とリン、硫黄の比 

* P（リン）、S（硫黄）を含む化合物の場合、チェックをかけ、適当な数値を    

入力することを推奨します。 

* 前ページの例では P, Sはリン酸、スルホン酸を想定しています。それ以外の  

場合はチェックを外す、あるいは数値を変更してください。 

￭ Use element limits…: リーズナブルな元素比率の組成式のみを表示 

￭ Consider also odd electrons…: ラジカルイオンを検索対象に含める場合 

* 使用する項目にチェックをかけてください。 

￭ Positive ions / Negative ions: 想定されるアダクトのタイプの選択 

 

Result Summary タブ: 結果表示の設定 

￭ m/z reporting format: 報告の形式 

￭ Order results by: 検索結果の順位づけ 

￭ Combined Ranking Contribution, : 検索結果の順位への MS, MS/MSの重みづけ 

￭ Weight MS/MS data…:検索結果の順位への MS/MS の重みづけ 

￭ MS error in: MSの入力、表示の単位 

￭ MS/MS error in: MS/MS の入力、表示の単位 

 

Dictionariesタブ; 使用するライブラリの指定 

* 検索された組成式からライブラリ検索を行います。 

￭ Confirm elemental…: Localライブラリの指定 

* 化合物情報を含むデータベースなどのファイルを 3つまで選択することができ

ます。選択可能なファイルの種類は、Analyst Database ファイル（*.mdb）、XIC 

Managerソフトウェアリスト（*.xiclist）、タブ区切りテキスト（*.txt）、構造デ

ータフォーマット（*.sdf）の 4種類です。 

￭ ChemSpider Service: On-lineで ChemSpiderサーチ、Databaseの選択 

* 使用には別途有償ライセンスと Web への接続が必要になります。 

* 使用する Databaseにチェック、あるいは、選択をしてください。 

* Databaseの情報、ChemSpiderについては ChemSpider の web site をご参照くださ

い。http://www.chemspider.com/ 
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 フラグメントの帰属 (Fragments Pane) 

* 推定された構造式から Fragment Ion の計算を行う、Fragment Ion から構造上の

解裂部分を帰属する機能です。 

* Mol file形式の構造式を使用します。ChemSpiderサーチの検索結果から呼びだ

す、あるいは、mol file形式の構造式をあらかじめ準備してください。 

* Trainingでは MSの画面を削除、あるいは隠してください。 

 前述を参考にフラグメントの帰属を行う MS/MS（および組成解析時は

FormulaFinder の画面）を表示します。 

 必要に応じて、スペクトルの Y軸上で、Label Threshold→の矢印を動かし、目的

のピークをラベルします。 

* Trainingでは変更しません。 

 構造式を開きます。 

i. ChemSpiderの検索結果から開く場合：Compound Detailsで目的の化合物の

構造を表示し、  をクリックして構造式を表示します。 

ii. それ以外の場合：Tool Barの Fileから Open mol file…を選択し、目的の mol 

file （Trainingでは MOLフォルダ内の Reserpine.mol）を開きます。 

    を MS/MS上にドラッグし、構造と MS/MSをリンクします。 

* 構造を変更した場合は同様に、リンクしてください。 

  Tool Barの Showから Fragments Pane を選択します。 

 

③ 

③-i 

② 

⑥ 

① 

⑦ 

⑨ 

MS/MS 
 

③-i 

④ 
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 Fragment paneの左上の    をクリックし、以下を参考に帰属の条件を設定、

OKします。 

* 化合物の構造に適した設定を行ってください。 

* Trainingでは以下の条件を使用してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fragment paneの左上の   をクリックすることで、帰属されます。 

 

  

Fragmentation 

• 単結合の開裂のみに限定 

• 環構造の開裂を許容 

• 最大開裂数 

• C-C の最大開裂数 

• ヘテロ原子と結合した  

    C-C の開裂の許容 

• 閉環の許容（2 重結合も加

味） 

• 開裂後の再結合の許容 

• ラジカルイオンの許容 

Peak List 

• 誤差範囲 

• スペクトル内にある Peakのみ

表示（Checkを推奨） 

• 2か所以上の開裂時、1か  

所開裂の Peakが帰属されたも

のに限る 

Display 

• 最小の m/z の指定 

• 構造式を変更した際に、自動

的に再計算する 

Fragment Pane 
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解析結果について 

 

￭ MS/MSの表示とラベルについて 

* Fragment Option で設定した条件下で青：構造上帰属できた Product Ion、赤：構

造上で帰属できなかった Product Ion になります。必要に応じて、Fragment 

Optionの設定を変更してください。 

* MS/MS上で Product Ionを選択することで、対応する部分構造が太線で表示さ

れます。また、MS/MS上の m/zの実測値が、選択した Ionの m/zからの差で表

示に変わります。実測値に戻す場合は画面上の   アイコン（Add arrows 

markers…）から Use Arrows for Relative Peak Labeling のチェックを外してくだ

さい。 

 

￭ MS/MSと構造式のリンク、コピーについて 

* MS/MS上の目的のピークをドラッグして選択することで、対応する部分構造が

太線で表示され、Fragmentの情報がハイライトされます。 

* 構造上の目的の部分構造を囲むことで、MS/MS上の対応する m/zに矢印が表示

されます。 

* 構造上をクリックし Tool Barの Editから Copyを選択することで、太線の部分

構造がクリップボードにコピーされます。 

 

 

 

MS/MS 

 ：構造上帰属できた Product Ion  

 ：指定した設定で構造上帰属できな Product Ion 

 ：選択した Ion、構造上に太線で表示 

ラベル：選択した Ion からの差で表示 
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￭ 構造式の修飾、変更について 

* 構造式左の元素を左クリック後、構造に近づけることで、構造への置換が可能

です。 

* 構造式内の変更、削除したい部分をドラッグし、右クリックから目的の変更を

行うことが可能です。 

* 構造式を変更した場合、同じ画面上の  アイコンを目的の MS/MS スペクト

ル上にドラッグ&ドロップして、再度、スペクトルと構造式のリンクを行って

ください。 

 

￭ ChemSpiderの検索結果使用時の構造式の変更と構造推定について 

*   ボタンをアクティブにすると、Formula Finder と Structure Pane がリンクさ

れます。複数化合物がリストアップされている場合、Formula Finder上で他の化

合物を選択すると、Structure Pane に表示される構造式も自動で切り替わります。 

* 切り替え後、再度 Fragment paneの左上の   をクリックすることで、帰属さ

れます。 

Tips: 未知物質の構造推定を行う場合、複数の候補化合物の中から、最も実際の

Product Ionに Matchする構造を探すのに役立ちます。 

 

  

MS/MS 

 ：指定した設定で構造上帰属できない Product Ion 

主な Product Ion が帰属できないことから、  

この構造の可能性は低いと推定される。 
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 疑似 Precursor Ion Scan、Neutral Loss Scan (Fragment Matching) 

～ 類縁体、目的の骨格を有する化合物の検索 ～ 

* IDA の MS/MS から、目的の部分構造に相当する Product Ion あるいは、Neutral 

Loss を用い、その部分構造を有する Precursor Ionを検出します。 

* 複数の Product Ion、Neutral Lossの入力が可能です。Or検索になります。 

* Trainingでは’IDA_wUV’の Dataから Melatoninの類縁不純物を検索します。 

 目的の Data (Trainingでは IDA_wUV)を IDA Exploreで開きます。 

 画面左上の   をクリックし、Options画面を開きます。 

 Fragment Matching の Tabで目的の Product Ion あるいは Neutral Lossを Fragment 

M/Z、Neutral LossM/Zに入力します。 

* Training では Melatonin の部分

構造に相当する、174.0913 を

Fragment M/Z に入力してくだ

さい。 

 OKをクリックし、検索を行いま

す。（検索が終了すると、

Matched Intの文字が黒に変わり

ます。） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 検索終了後、Filtering Controlsの Matched Int (%)の Minimumを適当な値に設定

し、Filter(抽出)を行います。 

③ 

② 

⑤ 

174.0913 
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* Matched Int (%)：指定したイオンの強度の積算のノイズ、Precursor Ion を除く全

Product Ion の強度の積算に対する比率 

* Trainingでは Minimumを 5%に設定してください。 

 

 

 

 

 

  

Merge 後の MS/MS の数 
 

Filter 後、Merge 後

の MS/MS の数 
 

検出された Ion 

(m/z 278.2) の MS/MS 
 

Matched Int: 0% 

（Filter なし） 

Matched Int: 5% 

（指定したイオンを 5%以

上有する precursor Ion） 
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 精密質量の計算 

 Tool Barの Showから Mass Calculatorsを選

択します。 

 Mass Propertyタブで解析する組成式を

Formula、Charge Stateに価数（数字）を入力します。 

* Negative Modeの場合はマイナスをつけてください。 

* Charge State 入力例: 

・Positive Mode: 1 

・Negative Mode: -1 

③ Positive Modeで+H、あるいは

Negative Mode で-Hを計算する場合

は、’H+’ charge agent (else electron)

のチェックボックスに    チェック

を入れます。 

④ Calculateをクリックします。 

 

 同位体分布の計算と重ね書き 

 Isotopic Distribution タブをクリックし、組

成を入力すると理論上の同位体ピークが表

示されます。 

* スペクトルに重ね書きする場合は、右上の   アイコンを目的のスペクトル

にドラッグしてリンクした後、Overlay pattern on spectrum にチェックをかけて

ください。 

 

 

 

 

 

 

 

 

 

 

 

* その他の Tabについては英文 Manualを参照ください。 
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MasterView による解析 

6 MasterView による解析 
 

￭ MasterViewは、PeakView上で動作します。 

￭ MasterView では、複数データ中の既知化合物の検索、ライブラリ検索、組成解析、未

知化合物の検索（含有成分の抽出）、2サンプル間の差分解析が自動でできます。 

￭ 複数の Dataを同時に開き、解析することが可能です。 

 

 新規 Library の登録 

※ 新規 Libraryを使用する場合に行います。 

※ 以前作成したライブラリを使用する場合は、6.2以降から操作を行ってくださ

い。 

 PeakViewを起動します。 

 メニューバーの File ->       Open Multiple Samplesから目的のデータを開きます。 

※ Training では、TT_Training/02_MasterView フォルダ内の「01-Data」、「02-Data」

を同時に選択して As a standard TIC の表示で 開きます。 

③ Peak Viewソフトウェアのメニューから、MasterView-> New Sessionを選択しま

す。 

④  (Launch LibraryView importer…) をクリックして、LibraryViewを開きます。 

⑤ 右下の Importをクリックし、使用するデータベースを選択します。 

※ Trainingでは、Analyst Compound Databaseをクリックし、D:\Analyst 

Data\Projects\TT_Training\Data\02_Master 

Viewフォルダ内の Free for Training.mdb

を選択します。 

⑥ Select/Deselect All Compoundsにチェック、ま

たは Allをクリックし、目的の化合物を選択

後します。 

⑦ Add To Compound Libraryに作成するライブラ

リ名（Training では Training）と入力して右下

の Nextをクリックします。 

⑧ Finishをクリックします。 

 

 目的、検索条件、結果の表示画面の設定 

※ Training では、現在開いている Session をそのまま使用します。③から始めて

ください。 

 PeakViewを起動し、メニューバーの File ->       Open Multiple Samplesから目的

のデータを開きます。 
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 Peak Viewソフトウェアのメニューバーから、MasterView -> New Sessionを  

クリックします。 

 （ settingsアイコン）をクリックします。 

 Calculationsタブで、以下を参考にピーク検出条件、差分解析の設定を行いま

す。 

※ Trainingでは、下図のように設定を行ってください。 

※ Non-Target 解析、自動組成解析を行わない場合は⑤、⑥のチェックを外して

ください。 

 

  

③ 

Peak検出時の

default設定 

*注意:RT  width

内の Peak はすべ

て Area 算出時に

積算されます。 

Non-Target Peak

検出時の設定 

(使用チェック) 

自動組成解析の設

定 

(使用時チェック) 

 

自動報告書作成

時の Template 

XIC の Threshold (Counts or  S:N) 

XIC 作成時の window 

XIC 作成時の RT の幅* 

Peak の Threshold  

差分解析時の強度比  

検出する RT の範囲  

検出の感度  

自動組成解析時の組成の上限とトレランス 
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 ライブラリーサーチを行う場合は、以下を参考に Library Searching タブで

Perform Library Searchingにチェックを入れ、条件設定を行います。 

※ Trainingでは、下図のように設定を行ってください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

【 検索アルゴリズムとソートについて】 

Algorithm        検索方法 

Candidate Search Algorithm Parameterに基づいて未知成分として検索 

Confirmation Search XIC Listの化合物名と一致するものを検索 

Smart Confirmation 

Search 

XIC Listの化合物名と一致するものを検索し、ヒットしない場合は Algorithm 

Parameterに基づいて検索。ライブラリでヒットした成分名を[Smart 

Confirmation]として表示。 

Fit 
ライブラリ中の MS/MSのピークが、Unknown スペクトルに対して、どれだ

け Hitしているのかで算出 

RevFit 
Unknown の MS/MSのピークが、ライブラリー中の MS/MSに対して、どれ

だけ Hitしているのかで算出 

Purity 両方のスペクトル間で、一致しなかったピークを算出 

 

 Columnsタブでは tableに表示するカラム項目を選択します。 

※ Trainingではデフォルトを使用します。 

検索アルゴリズ

ム、並び替え条件 

使用する 

ライブラリ 

検索条件 

* 

* 

Search all Libraries あ

るいは、使用するライブ

ラリにチェック 

* リストにない場合は、

「6.1.新規 Library の登録」

から作成、登録を行ってくだ

さい。 

ページ下を参照ください。 

Tolerance 

* 使用する Data、ラ

イブラリに応じて設定

してください。

TripleTOF の data で作

成された Library の場

合、通常 5mDa になり

ます。 

 詳細設定 

* 変更される場

合は Help を参照

ください。 
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 Confidence Settingタブで

は、質量誤差、保持時間

等の各項目における信頼

度の設定を行います。 

※ Trainingではデフォ

ルト（右図）を使用

します。 

 OKをクリックし、

settingsを閉じます。 

 

 目的化合物の情報の入力 

※  Non-target解析（目的化合物がない）場合は 6.4に進んでください。 

 

 Tableに目的の化合物情報を入力します。 

i. Manualで入力する場合： 

Formula と Adductあるいは、Mass (Da)を入力します。その他必要に応じて

情報（化合物名、Retention Timeなど）を入力します。Excelなどから、リ

ストのコピー＆ペーストも可能です。 

ii. 以前に作成、保存した Listを使用する場合： 

   Import compound Info from csv fileから Fileを選択し、OKをクリック

します。 

iii. Libraryにある化合物リストを使用する場合： 

  Import compound Info from Library Viewをクリック

し、既知化合物リストとする Library（Trainingでは、

Training）を選び、OKをクリックします。 

 必要に応じて   Export compound Info from csv fileから Listを保存します。 

 Processをクリックし、解析を行います。 

 

① 
 

① 
 

② 
 

③ 
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 結果の確認 

i. 選択したデータについて、検出された結果が Session paneにリスト表示さ

れ、Positive Result 設定をクリアした成分(Positive Hit)が緑でハイライトさ

れ、Number of positive resultsに数が表示されます。 

ii.  にチェックを入れると、緑で表示された成分のみの表示になりま

す。 

iii. 各カラムのタイトル(Mass (Da)など)をダブルクリック、ドラッグすること

で、それぞれ列内のソート、列の表示順を変更することができます。 

 サンプル間の比較 

 画面左下の Positive Resultsの設定をすべて解除（グレーに変更）します。 

 画面下の Sample. Controlを選択します。 

 検出された Peak 中、Threshold (ratio of control)で設定された差（Trainingでは

50倍）以上、差がある成分について、Positive Hitとして表示されます。 

※ Trainingでは、Sampleに 01-Dataの Orange，Controlに 01-Dataの Organic 

Orangeを選択し、Imazaril で確認してください。 

 

 

 

 

 

 

 

 

 

 ① 
 

選択した Peak の XIC 

Session pane: Target List および

Non-Target 検索で Hit した Peak

の List と情報 (name は m/z / RT

で表記、Positive Hit は緑でハイ

ライト) 
Positive Results の設定 

i 
 

ii  
 

iii  
 

i. 各データ中の

Positive Hit 数 

選択した Peak の
XIC 

Sample Control 

② 
 

ii 
 

i 
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 MS、MS/MS、ライブラリーHitの確認 

  Show MS and MS/MS             をクリックすると、選択した Peak について Sample

（上段）、Control（下段）に MS（左）および MS/MS（右）が表示されます。 

※ MS/MSが取得されていない場合は表示されません（例：Control）。 

 Libraryに Hitした場合、MS/MS画面で Libraryのスペクトルがミラーで表示され

ます。表示される青が測定値、下側のグレーが Library中のスペクトルになりま

す。 

 Listを右にスクロールすることで、Hitした化合物名、Scoreを確認することがで

きます。 

※ スペクトルで表示する Libraryの Hitを変更することができます。 

 MS、MS/MSの表示を消す場合は再度同じ   Show MS and MS/MSを クリ

ックしてください。 

 

 

 

 

  

② 

 

③ 
 

Sample 

Control 

MS MS/MS (    実測、  Library) 
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 詳細情報の確認と Chemspider Search、Product Ionの帰属 

※ Trainingでは、Imazarilで確認してください。 

 Show  XIC Details             をクリックすると、選択した Peakの行の下に

Library Hit, 組成解析結果の詳細な情報が表示されます。 

 Listを右にスクロールすることで、Hitした化合物名、Scoreを確認するこ

とができます。 

iii. 組成解析結果（trainingでは C14H14Cl2N2O）をクリックします。 

iv. Chemspider検索結果画面が開き、自動で MS/MSの帰属が行われます。 

※ サーチ結果の List で化合物を選択しなおすことで、構造、帰属が自動で更新

されます。 

v. 推定した構造を選択し、Selectをクリックすることで、目的のピークに構

造式が保存され、結果の Mol欄に構造式が表示されます。 

v 

MS/MS 

青：構造上自動帰属できた Product Ion  

ChemSpider サーチ結果 

選択した化

合物の構造 

自動比較 

③-i 

 

Library Hit の詳細情報 

組成解析の詳細情報 
(Hit Count: ChemSpider

の Database での化合

物 Hit 数) v 
iv 

ii 
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 保存と印刷  

 解析結果の保存 

i. Save session    をクリックします。 

※ Trainingでは、Trainingと入力します。 

※ 開く場合は、メニューバーの MasterView/Open Resultから開きます。 

 

 MultiQuant、MarkerView用の解析結果の保存 

i. Save MultiQuant Method as Text…    ボタンで、MultiQuantのテキスト  

メソッドとして、Save As MarkerView Peaks…    ボタンで、

MarkerViewの Peaksファイルとして保存できます。 

 

 解析結果の wordレポート作成 

i. Generate Report   をクリックし、目的の Template（Training では

FilterByPositiveHit）を選択

し、 Openを選びます。 

ii. 保存先、ファイル名を指定

し、保存を行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

報告書例 
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定量解析（MultiQuant™ Software） 

7 定量解析（MultiQuant™ Software） 

※ MultiQuantTM Softwareは、TripleTOF®シリーズで取得したデータを用いて定量

を行うためのソフトウェアです。TOF MS、Product Ion、MRMHR（TOF 

MS+Product Ion）、Scheduled MRMHR 等で取得したデータについて、定量を行

います。 

※ Training で は 、MRMHR（TOF 

MS+Product Ion）で取得したデータ（右

表の溶液）を使用します。 

※ MultiQuantTM Softwareの詳細な説明につ

きましては、ユーザーマニュアル（日

本文、英文）、Reference Guide (英文)を

参考ください。 

※ 英文の資料につきましては、MultiQuant 

Software の Help から参照することが可能です。 

 

 ソフトウェアの起動 

 Analystの Navigation Barの MultiQuantをダブルクリック、あ

るいは、Desktop のショートカットをダブルクリックし、

MultiQuantを立ち上げます。 

 以下の画面が表示されるので Neitherを選択し、プロ

ジェクトを選択します。 

※ Trainingでは Project：TT_Trainingを選びます。 

 

 

 初期設定 

 ツールバーの Edit -> User Integration Defaultsを開

き、使用するアルゴリズムを選択します。Trainingでは

MQ4を使用し、右図の通りに入力します。 

 ツールバーの Edit -> User Units & Calibration Defaults を開

き、使用する濃度単位、定量計算に用いるパラメータ、

検量線の条件を設定します。 

※ Training では単位は空カラム、その他は図のように

入力します。 

 

 

  

APCI Positive Calibration Solution 

STD0 Blank 

STD1 1000 倍希釈 ( 0.001 ) 

STD2 100倍希釈 ( 0.010 ) 

STD3 10倍希釈 ( 0.100 ) 

STD4 原液 ( 1.000 ) 

Unknown 33倍希釈 ( 0.030 ) 

① 
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 定量解析 

 File -> New Results Tableにて解析するデータを選択し、画面右側にサンプルを

移動させたら、Nextをクリックします。 

※ Training では 03_MultiQuant フォルダ内のデータすべて選びます。

03_MultiQuantフォルダをクリックし、⇒をクリックします。 

 Create New Method(MQ4)を選択した後 Newをクリックし、ファイル名を入力して

Saveします。元の画面に戻って Nextをクリックします。 

※ Trainingでは Reserpineと入力します。 

※ 2回目以降の定量解析では、Chose Exiting Methodの Openから既存の定量 メ

ソッドを使用することができます。 
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 ピーク認識を行うための代表サンプルを選

択し、Nextをクリックします。 

※ Trainingでは STD3を選択します。 

④ 化合物名と定量に使用するイオンの情報を入

力します。 

※ Trainingでは以下のように入力します。 

・Experimentのプルダウンから “1 TOFMS”を選択し、Name：Reserpine-MS、Start-

Stop：609.2807-0.02（Precursor Ionの精密質量-Width (Da)）と入力します。 

・Experimentのプルダウンから“7 TOF PI of 609.3”を選択し、Name：Reserpine-PI、

Start-Stop：195.0652-0.02（Product Ionの精密質量- Width (Da)）と入力します。 

 

※ 複数の Product Ionを合算する場合は、テーブル上で右クリック→Sum Multiple 

Ions を選択すると、Product Ion を入力するカラムが増え、複数入力できるよ

うになります。 

 

※ Scheduled MRM アルゴリズムを用いた測定で、定量したい化合物がどの

Experiment で測定されているかわからないときには、PeakView® Software  

などでデータを開いて確認します。 

 

⑤ Nextをクリックすると、すべての Experimentを確認していないとの警告が出ま

すので、OKをクリックします。 

⑥ 代表サンプルのピークが自動で積分されるので、MS および PIの両方について確

認をします。 

※ 積分されていない場合は、左ドラッグでピーク部分を囲みます 

※ 複数化合物がある場合はすべてについてピークが積分されているか確認しま

す。 

 

 
  

Product Ionを複数入力できます。 
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⑦ Outlier Settingsでは、必要に応じて、真度からの外れ値にフラグを付けることが

できます 

※ Trainingではすべてのチェックを外します。 

※ 基準から外れている測定結果の文字は黒からピンクに変わります。 

⑧ 確認が終了したら Finishをクリックします。 

 

⑨ Result Tableが作成され、表示されます。 

※ メニューバーから Edit -> Cache all Chromatograms Now を選ぶと、一度

Chromatogram を開いた後、キャッシュにクロマトのデータが保存されるので、

その後の表示（動作）が早くなります。 

⑩ 表示するカラムや桁数を変更したい場合は、テーブル上で右クリック→Column 

Settingsで設定を行います。入力した Format通りに有効数字や対数表示が切り替

わります。 

※ Training で は 、Actual Concentration の

Number Format に 「0.000」と 入力し 、

Sample ID、IS Name、Component Group 

Name の「Visible」のチェックをはずし、非

表示にします。 

※ ここで入力した有効桁数以上の値は、定量

テーブルに入力表示されないだけでなく、

定量計算にも反映されません。 

⑪ サンプルタイプと標準溶液濃度を図のように入力します。サンプルタイプはプル

ダウンから選択します。すべての Componentsについて入力します。 

※ Actual Concentration に入力した値を他の全ての Component に反映させるには、

テーブル上で右クリックし、Apply Current Analyte’s Actual Concentrations to All

を選択します。 

化合物名 (Component) 

をクリック 
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⑫  をクリックし、検量線及びピークを表示させます。Result Table、クロマト

グラム、検量線はリンクしており、別の Componentを選択すると表示が変わり

ます。 

 

※ 複数の化合物がある時、比較したい成分を Controlキーを押しながら複数選択

することができます。この場合、Result Table とクロマト表示画面には選択し

た化合物のすべての情報が表示され、検量線は重ね書きされます。 

※ Blank データなど、不検出にしたいデータを選択後、クロマト表示画面の  

ボタンをクリックすると、ピークの不検出指定をすることができます。 

※ Result TableのUsedカラムのチェックを外すと、そのデータポイントを検量線

から除外することができます。 

⑬ ツールバーの File -> Save Asで名前を付けて保存します。 

※ Trainingでは、Trainingと名前を付けて保存します。 

※ 必要に応じて、Report を作成しま

す。ツールバーの File から Create 

Report を選択し、目的のテンプレ

ート、出力形式を選択し、名前を

付けて OKをクリックします。 

 

  

定量結果 

検量線 

Component 

ごとに表示 

クロマトグラム 

 

定量値 
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装置のチューニング 

～Instrument Optimization～ 

8 装置のチューニング ～Instrument Optimization～ 

* 最良の感度、分解能で測定するため、質量分析計の各パラメータを自動で最適

化する機能です。装置のメンテナンスによる真空の解除、復帰後など、分解能

が不十分な場合に実施してください。 

* 標準溶液として、以下の溶液を使用します。TOF MS 測定にて、あらかじめ 

ピークが検出されていることを確認しておきます。 

 

 極性 使用する溶液 

6600  

& 5600+ 

Positive APCI Positive Calibration Solution 原液(#4460131) 

Negative APCI Negative Calibration Solution 原液(#4460134) 

4600 
Positive & 

Negative 

Tuning Solution (CsI 500nM / Sex Pheromone Inhibitor iPD1 50nM, #4457953)：
Taurocholic acid (1ng/uL, #4405241) =1:1 

 

 Navigation Barの Instrument Optimization をクリックし、

Instrument Optimization を起動します。 

 右図のメッセージが表示された場合、OK

をクリックし、Backup を取ります。 
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 下図を参考に Instrument Optimization画面で、目的の Polarity、使用する Tuning 

Solutionを選択します。 

 Verify Performanaceのチェックを外します。 

 Select the instrument components to Optimize で必要な Modeにチェックをかけて

選択後、Nextをクリックします。 

* Enhance機能で使用する場合は Enhance Ion にチェックをかけます。 

* 分解能が改善しない場合は TDC Initialization にチェックをかけて実行します。 

 

TripleTOF® 6600 / 5600+ Systemの画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TripleTOF® 4600 Systemの画面 

 

 

* CsI_Taurocholic acid

が リストにない場

合は、Taurocholic acid

の Reference Table を

Copy して TOFMS の

Reference Tableのリン

酸イオン m/z 79.9568

をヨウ化物イオン m/z 

126.9050 に変更して

作成してください。  

選択しないで

ください。 
 

④ 
③ ③ 

⑤ 

⑤ 

選択しないで

ください。 
 

④ 
③ ③ 

⑤ 

 

Positive: APCI Positive Calibration Solution 
Negative: APCI Negative Calibration Solution 
 
 

Positive: CsI_ALILTLVS_Reference 
Negative: CsI_Taurocholic acid* 
 
 

⑤ 
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⑥ 必要に応じ、Fileから Backup Instrument Settings 

Filesを選択し、保存名を入力して保存します。

（現在のパラメータが保存されます。以前行っ

た設定に戻す場合は、Fileから Restore 

Instrument Settings Filesを選択し、backup したファイルを選択します）。 

⑦ 下図を参考に、イオン源の設定（初期値でも使用可能）と使用するシリンジの内

径と Flow Rate を入力し、Go!をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

⑧ 自動最適化が実行され、結果のレポートが作成されます。 

* 印刷にて pdfにて保存することができます。 

* データは、以下の場所に、取得日時の入ったフォルダ名で保存されます。 

D:\Analyst Data\Projects\API Instrument\Data\Instrument Optimization   
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メンテナンス（イオンソースおよび

インターフェース） 

9 メンテナンス（イオンソースおよびインターフェース） 

イオン源、カーテンプレート、オリフィスプレートのメンテナンス 

* 装置が稼動している状態で行うことができます｡装置を止める必要はありませ

ん。 

* 作業中は、パウダーフリーのノンラテックス製の手袋を着用してください。 
 

 Tune Modeか Acquire Modeで、Tool Barの Queue manager  をクリック後、

Stand by をクリックして装置を Standbyにします。 

※ 測定を行っている時は、測定を中止するか

終了するまでお待ちください。 

② イオン源両側のレバーを上げて、イオン源の固

定を解除します。 

③ イオン源を軽く持ち上げながら手前に引いては

ずします。 

④ オリフィスプレートをおさえながら、カーテン

プレートまっすぐ手前に引いて取り外します｡ 

⑤ 取り外したカーテンプレートを 50% メタノール

や 50% アセトニトリル等で拭きます｡ 

⑥ オリフィスプレートのオリフィス孔の周辺を、

スワブを使用して、50% メタノールや 50% アセ

トニトリル等で拭きます｡ 

※ キムワイプは使っているうちに細かい屑が出ま

すので、オリフィスプレートには使わないで下さい｡ 

※ オリフィス孔は薄いので変形させないように注意してください｡ 

⑦ カーテンプレートを戻します｡ 

⑧ イオンソースを本体へ戻します。 

[メンテナンスに使用する備品について] 

• スワブ：精密機器の清掃に使用する綿棒状の清掃用具です 

•  Chemtronics 社製の Foamtips が推奨です。 

• 大：Cat.No.CF2050（オリフィス表面の清掃用など） 

• 中：CF3050 (スキマーや QJet® ion guide の清掃用など) 

• 小：CF4050（オリフィス孔の清掃用など） 

• ノンラテックス製手袋：MICRO FLEX 「ネオプロ」など 

レバー カーテン 

プレート 

オリフィス 

プレート 

オリフィス孔 
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装置の再起動、停止および起動
(Shutdown & Startup) 

10 装置の再起動、停止および起動（Shutdown ＆ Startup） 

 

 装置の再起動 

 測定終了後、Tune Modeか Acquire Mode

で、Tool Barの クリック後、 をクリ

ックして装置を Standbyにします。 

 本体の背面の電源スイッチを切り 15秒程度

後、再度立ち上げます。 

 必要に応じて PCも再起動します。 

 本体内部の真空度が戻るまで数分待ちま

す。 

 

 装置の停止 

 測定終了後、Tune Modeか Acquire Mode

で、Tool Barの クリック後、 をクリックして装置を Standbyにします。 

 本体の電源スイッチを切り、15分程度待ちます｡ 

 外部のロータリーポンプを切ります。 

 必要に応じて PCも終了します。 

※ メンテナンスの場合は特に必要ありません。 

 本体内部が大気圧に戻るまで 30分以上待ちます。 

 Circuit breaker switch のカバーを外し、Circuit breaker switchを切ります。 

 必要に応じて、電源ケーブルを抜き、ガスの供給を切ります。 

 

 装置の起動 

 ガスを供給します｡ 

 N2ジェネレータの場合は酸素濃度が安定するまで (約 10分) お待ちください。 

 電源ケーブルをさします。 

 PCの電源を切っていた場合は PC立ち上げ、Log inしてください。 

 外部のロータリーポンプを立ち上げます。 

 Circuit breaker switch のカバーを外し、Circuit breaker switchを入れます。 

 電源スイッチを入れます。 

 Analyst® TF software を起動し装置の状態を確認してください｡ 

 

背面 

電源スイッチ 

Circuit breaker 
switch 
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トラブルの回避と対処 

11 トラブルの回避と対処 

 トラブルの回避 

※ テンポラリーファイル（*.tmp）やバックアップファイルがハードディスクを

圧迫しているためにコンピューターの動きが遅くなることがあります。この

ため定期的に以下の作業を行うことを勧めます。 

 すべてのソフトウェアを閉じ、PCを再起動します。 

 起動後、Start → Search Programs and Filesに*.tmp と入力し、

エンターします。 

 開いた画面で検索場所を Computerに変更し、

再度検索します。 

 得られた検索結果すべてを削除します。 

 Are you...のメッセージが出ますので Yesをクリックします。 

 消去できない File以外を deleteし、検索画面を終了します。 

 デスクトップ上の Recycle Binを右クリックし、Empty trashでごみ箱を空にしま

す。 

 

 トラブルの対処１ 

※ errorなどが生じた際に、以下の方法で対応してください。 

 Analyst® TF software を終了します。 

 Desktopの をダブルクリックします。 

 AnalystService を選択後、 あるいは Stopで AnalystServiceを終了します。 

 HPLC との接続で Errorが生じた場合は、必要に応じて HPLC 再起動します。 

※ Waters 社の HPLC を使用している場合は、HPLC 再起動後、②の Service 画面

で Acuity Service を起動します。 

 Analyst® TF software を再度立ち上げます。 

※ 以上の方法で Hardware Configurationできないなど Analyst Softwareが正常に起

動しない場合はトラブルの対処 2へ進んでください。 

 

 トラブルの対処 2 

※ トラブル対処１の方法で解決しない場合は、以下の方法で対応してください。 

 トラブルの対処１の方法で Analyst® TF software, AnalystServicesを終了します。 

② コンピューターを再起動後、Analyst® TF software を再度立ち上げます。 

※ 以上の方法で Analyst Software が正常に起動しない場合はトラブルの対処 1の

方法で再度 Analyst® TF software、AnalystServices を終了後、Analyst® TF 

software を再起動してください。 
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添付資料 

12 添付資料 

 

 Reference Table の編集・作成 

※ Trainingでは行いません。 

 

① Analystのメニューバーから、Tools -> Settings -> 

Tuning Options…を選択します。 

② 開いた Tuning Options のウィンドウ上で、

Referenceボタンを押します。 

③ Reference Table Editor で、Newボタンで新規にテ

ーブルを作成するか、Copyボタンで既存のテーブルをコピーして Name に名前を

つけて編集します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

④ TOF MS で設定した化合物中の 1化合物の Use for MS/MSにチェックをかけ、

MS/MS用のキャリブレーションイオンに選択し MS/MS測定の条件を入力します。 

※ MS/MSで各 2つ以上のキャリブレーションイオンを選択(Useにチェック)しま

す。 

※ 溶液の導入に CDSを使用する場合は、右上の Calibration Valve Position に溶液ボト

ルを接続した Valve Positionを選択します。 

⑤ OKを押して Reference Table Editorウィンドウを閉じます。 

⑥ Tuning Optionsウィンドウで、Update Std.ボタンを押した後、OKを押して Tuning 

Optionsウィンドウを閉じます。 

TOFMS 用テーブル Product Ion 用テーブル 
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 CDS の動作について 

※ CDS のラインにエアが混入していると送液が行われず、Auto Calibration が失

敗する場合があります。その場合は、下記に示すように Purgeを行います。 

① Navigation Barの Manual Tuningをダブルクリックし、Tune Method Editor画面を

起動します。 

② Polarityには分析する極性を選び、CDS Purge を押します。 

※ 通常、Calibration Valve Positionは Positive Mode：A、Negative Mode：B です。 

 

 

 

 

 

CDS Inject:  

ボタンを押すと、Calibration Reference Tableで

設定した溶媒ボトルから CDS Inject flowrate で

設定した流速で標準溶液を導入します。 

CDS Refill:  

CDS Refill/Purge flow rateで設定した流速で、溶

液の補充を行います。通常は、1000μL/min で変

更する必要はありません。 

CDS Purge:  

パージ動作を行います。パージ動作は、CDS 

Refill/Purge flow rate で設定した流速で、現在シ

リンジを満たしている溶媒の排出、その後、次

に使用する溶液の補充の動作をそれぞれ２回行

います。 

※ 約 5分程度かかります。 

 

CDS 使用時の注意点 

￭ CDS を APCI プローブへ導入し、キャリブレーションに使用している場合、APCI でイオン

化するため、Gas2, TEM の値が必ず必要です、GS2や TEMが 0 ではイオン化が起こりませ

ん。一例として、GS2=50, TEM = 550 など、どちらも、APCI のイオン化が可能な数値を入

力してください。 

￭ ESI プローブを利用する場合、酢酸アンモニウムや、ギ酸アンモニウムなどのバッファー

を添加した溶媒のほうが、感度がよく安定したイオン化が期待できます。 

￭ APCI, ESI ともに、相互にスプレーの干渉があるため、HPLC を流した状態でプローブのポ

ジション等をある程度最適化をする必要があります。 

特に ESI から、CDS 溶液を導入する場合、高分子側のピークがプローブポジションの影響を

受けることがあります。これらのピークがうまく検出されない場合は、ESI プローブをオリフ

ィス孔に対して近づけてみてください。 
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 Library への登録（LibraryView® Software） 

* IDA で取得した MS/MSを LibraryViewを使って登録する方法です。 

 LibraryView® Software を開きます。 

  をクリックし、登録する化合物情報を入力します。 

※ 化合物名と Formulaは必ず入力してください。 

※ Trainingでは化合物名 Training-Reserpine、Formula: C33H40N2O9、構造式を登

録します。構造式は TT_Training\Data\Mol Filesの Reserpine構造式を使います。 

 MS Spectraタブをクリックします。 

 Save Changesのメッセージが出ますので Yesをクリックします。 

  Edit Mode、  Add Spectraをクリックし、登録するデータファイル

（Trainingでは Data\02_MasterViewにある 04_Reserpine_IDA）を選択します。 

 Nameの三角印をクリックします。 

 登録したい MS/MSを Mass、RTの情

報を基に選択します。 

* Trainingでは Mass: 609.3、RT: 2.95min を選択してください。 

⑧ Add Spestramをクリックします。 

⑨ Saveをクリックすることで登録されます。 

 

  

③ 

⑨ 

⑧ 

⑦ 

⑥ 
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 MasterView を利用した MRMHRの定量解析メソッドの作成 

MRMHRの定量メソッド作成は MasterViewを使用した方法が便利です。 

 

 PeakViewのツールバー-> MasterViewから New Sessionを選択し、MRMHRで取

得したデータを開きます。 

* Trainingでは 03_MultiQuantフォルダの MRMHR_STD4を使用します。 

 

Precursor Ion の情報のみ登録の場合 

 各カラムにおいて Name：化合物名、Mass (Da)：Precursor Ionの m/z 値、

Width(Da)：幅（例 0.02：±10mDa）を入力します。 

* 予め組成式が分かっている場合は Formula カラムに入力し、Adduct カラムに付

加イオンを入力します。Extraction Mass (Da) カラムは自動計算されます。 

* Excelからコピー&ペーストができます。 

 Processボタンをクリックしてピーク抽出を行います。 

 Save MultiQuant Method As Textボタン  をクリックし、名前を付けて保存しま

す。 

 MultiQuant ソフトウェアを起動し、ツールバーの File -> Import -> Quantitation 

Method form Text にて③で保存したファイルを選択し、Open をクリックします。 

 Select Sample 画面が表示されるので、代表サンプルを 1つ選択し、OKをクリッ

クします。 

* Trainingでは 03_MultiQuantフォルダの MRMHR_STD4を使用します。 

⑥ ①で設定した情報を確認します。 

 

 

 

 

 

 

 

 

 

 

 

予めわかっている場合は入力 
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Precursor Ion / Fragment Ion の情報を登録した場合 

 各カラムにおいて Name：化合物名、Mass(Da)：Precursor Ionの m/z 値、

Width(Da)：幅（例 0.02：±10mDa）、Fragment Mass：定量に使用する Product 

Ionの m/z値を入力します。 

* Training では Reserpineの Product Ion m/z195.065 を Fragment Mass カラムに入力

します。 

 Processボタンをクリックしてピーク抽出を行います。 

* Extraction Experiment (#) は自動認識されます。 

③ 上述の③～⑤の操作を行います。 

④ ①で設定した情報を確認します。 

* MasterView で Fragment Mass カラムに入力した化合物は、MultiQuant 上では

Experiment 1 TOF MSから Precursor Ion 情報が除かれ、代わりに Experiment X  “X 

TOF PI of XX（ここでは Experiment 7 TOF PI of 609.3）に、定量に使用する

Fragment Massの情報が入ります。この成分の MS定量をするには、手入力で情

報を追加します。 

⑤ 各 Experimentの内容を確認後、File -> Save Asで定量メソッドを保存します。 

⑥ File -> New Results Table にて解析するデータを選択し、Nextをクリックします。 

Choose Existing Method にチェックをかけ、Open ボタンをクリックして⑤で 

保存したメソッドを選択します。Open ボタンをクリックして元の画面に戻り、

Finish ボタンをクリックすると定量テーブルが作成されます。 
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 LC 条件の追加、修正 - ExionLCTMの場合 

 Sciex LC Systemをクリックします。 

② Binary Gradientの Tabで Flow Program右の   をクリックして展開し、溶出

条件を入力します。 

③ 必要に応じて、Compressibility settings, Autopurge settingsについて   を  

クリックし、設定変更を行います。 

※ Trainingでは下図のように入力してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Autosamplerをクリックし、Injection Volumeを入力します。またニードルウォッシュの設

定を行います。 

④ MS の測定時間と LC の時間の確認を行います。 

 MS の測定時間を変更する場合は、Mass Spectrometerをクリックし、Durationに

適当な値を入力してください。 

 

① 

① 

③ 

③ 

③ 

③ 

② 
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⑤ 必要に応じて、Autosamplerの Tabで条件を設定、変更します。 

* Trainingでは変更しません。 

* ニードルウォッシュを使用する場合は、Rinse settingで設定を行ってください。 

目的の Rinse Type を選択することで、詳細設定が可能になります。 

⑥ 必要に応じて、Column Oven の Tab

で条件を設定、変更します。 

* Column Oven を使用する場合、

Column Oven にチェックをかけ、

温度設定してください。 

* Trainingでは 40℃に設定します。 

* Oven の内蔵バルブを制御する場

合は、設定を行ってください。 

⑦ Injection をクリック

し Injection Volume

を入力します。 

* Training では 5 を

入力してくださ

い。 

 

⑧ Menu Barの Fileから Saveを選択し、Methodを保存します。  

5 
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 LC 条件の追加、修正 - Waters 社製 HPLC（Acquity I-class）の場合 

 

① Navigation Barの ACQUITY Method Editorをダブルクリッ

クし、Waters Method Editor画面を立ち上げます。 

② メニューバーの File -> Open Method から、目的の Method

（Trainingでは IDA）を選択して開きます。 

 

③ Run Timeに測定時間を入力し

ます。 

④ Trainingでは右図のように入

力してください。必要に応

じ、ACQ-PDAタブで PDAの

設定を行います。  

 

 

 

 

 

⑤ ACQ-CMタブをクリック

し、必要に応じて温度を設定

してください。 

 

 

 

 

 

 

 

⑥ ACQ-FTN（Sample Manager 

FTN）タブをクリックし、オ

ートサンプラーの設定をしま

す。 

* Training では図のように

設定してください。 
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⑦ ACQ-BSMタブをクリックし、グラジエントの条件を入力し、入力後、MSの測

定時間の確認を行います。 

* Trainingでは下図のように設定してください。 

入力後、   をクリックすることで、下図のグラフが表示されます。 

⑧ メニューバーの File -> Saveを選択し、目的の Method（Trainingでは IDA）に上

書きします。 

⑨ メニューバーの File -> Exitを選択し、画面を終了します。 

⑩ Build Acquisition Methodをクリックし、Fileメニューの Openから目的の   メ

ソッド（Trainingでは IDA）を開き、ACQUITY UPLC Systemをクリックすると

LC 条件が表示されます。 

* Injection Volume は Batch作成時に設定します。 
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 LC 条件の追加、修正 - CTC PAL Autosampler を使用する場合 

* オートサンプラーのみの設定です。 

 CTC PAL Autosamplerをクリックします。 

 Injection Volume に注入量を入力します。 

* シリンジ容量を超えないようにしてくださ

い。 

 Available Cyclesで洗浄メソッドを選択します。 

 Syringeで装置に取り付けられているシリンジの

容量を選択します。 

 必要に応じて、Cycle Augumentsの内容を変更します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

② 

③ 

④ 

⑤ 
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◆製品サポートのご案内◆ 

株式会社エービー・サイエックス / アプリケーションサポート部まで、 

ご使用の装置名（TripleTOF® System）とシリアル番号をお伝えください｡   

 Tel: 0120-318-551 Fax: 0120-318-040 

 E-mail: jp_support@sciex.com 

 

◆オンライントレーニング動画のご案内◆ 

弊社ホームページの下記サイトから、メンテナンス、ソフトウェアの使用法など、各種ト

レーニング動画を視聴できます。是非ご活用ください。 

Home > サポート > 各種サポート資料・ツール > 操作方法に関する動画 

http://sciex.jp/support/support-tools/movie-manuals 

Home > Support > SCIEXNow > Training > Course Catalog 

  http://sciex.com/support/training-front/course-catalog 
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